
 
 
 
 
 
This Computer program (including software design, programming structure, 
graphics, manual, and on-line help) was created by the pcaStructurePoint, the 
Engineering Software Group of the Portland Cement Association.  
 
Winsoft Software Inc. of Ottawa, Ontario, Canada, assisted in the development of 
the graphical interface. 
 
 
 
While the Portland Cement Association has taken every precaution to utilize the existing state-of-the-
art and to assure the correctness of the analytical solution techniques used in this program, the 
responsibilities for modeling the structure, inputting data, applying engineering judgment to evaluate 
the output, and implementing engineering drawings remain with the structural engineer of record. 
Accordingly, Portland Cement Association does and must disclaim any and all responsibility for 
defects or failures of structures in connection with which this program is used. 
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PORTLAND CEMENT ASSOCIATION  
EVALUATION SOFTWARE LICENSE AGREEMENT 

 
BY CLICKING THE “I AGREE” ICON BELOW, OR BY INSTALLING, COPYING, OR 
OTHERWISE USING THE SOFTWARE OR USER DOCUMENTATION, YOU AGREE TO BE 
BOUND BY THE TERMS OF THIS AGREEMENT, INCLUDING, BUT NOT LIMITED TO, THE 
WARRANTY DISCLAIMERS, LIMITATIONS OF LIABILITY AND TERMINATION 
PROVISIONS BELOW. IF YOU DO NOT AGREE TO THE TERMS OF THIS AGREEMENT, DO 
NOT INSTALL OR USE THE SOFTWARE OR USER DOCUMENTATION, EXIT THIS 
APPLICATION NOW AND RETURN THE SOFTWARE AND USER DOCUMENTATION TO 
PCA.  
PORTLAND CEMENT ASSOCIATION, 5420 OLD ORCHARD ROAD, SKOKIE, ILLINOIS 60077 
(HEREAFTER PCA), GRANTS THE CUSTOMER A PERSONAL, NONEXCLUSIVE, LIMITED, 
NONTRANSFERABLE LICENSE TO USE THIS SOFTWARE AND USER DOCUMENTATION 
SOLELY FOR TRIAL AND EVALUATION PURPOSES ONLY IN ACCORDANCE WITH THE 
TERMS AND CONDITIONS OF THIS AGREEMENT. SOFTWARE AND USER 
DOCUMENTATION IS SUPPLIED TO CUSTOMER EITHER BY PCA DIRECTLY OR 
THROUGH AN AUTHORIZED DEALER OF PCA (HEREAFTER DEALER). 
WHILE PCA HAS TAKEN PRECAUTIONS TO ASSURE THE CORRECTNESS OF THE 
ANALYTICAL SOLUTION AND DESIGN TECHNIQUES USED IN THIS SOFTWARE, IT 
CANNOT AND DOES NOT GUARANTEE ITS PERFORMANCE, NOR CAN IT OR DOES IT 
BEAR ANY RESPONSIBILITY FOR DEFECTS OR FAILURES IN STRUCTURES IN 
CONNECTION WITH WHICH THIS SOFTWARE MAY BE USED. DEALER (IF ANY) HAS NOT 
PARTICIPATED IN THE DESIGN OR DEVELOPMENT OF THIS SOFTWARE AND NEITHER 
GUARANTEES THE PERFORMANCE OF THE SOFTWARE NOR BEARS ANY 
RESPONSIBILITY FOR DEFECTS OR FAILURES IN STRUCTURES IN CONNECTION WITH 
WHICH THIS SOFTWARE IS USED. 
PCA AND DEALER (IF ANY) EXPRESSLY DISCLAIM ANY WARRANTY THAT: (A) THE 
FUNCTIONS CONTAINED IN THE SOFTWARE WILL MEET THE REQUIREMENTS OF 
CUSTOMER OR OPERATE IN COMBINATIONS THAT MAY BE SELECTED FOR USE BY 
CUSTOMER; (B) THE OPERATION OF THE SOFTWARE WILL BE FREE OF ALL "BUGS" OR 
PROGRAM ERRORS; OR (C) THE SOFTWARE CONFORMS TO ANY PERFORMANCE 
SPECIFICATIONS. CUSTOMER ACKNOWLEDGES THAT PCA IS UNDER NO OBLIGATION 
TO PROVIDE ANY SUPPORT, UPDATES, BUG FIXES OR ERROR CORRECTIONS TO OR FOR 
THE SOFTWARE OR USER DOCUMENTATION.  
THE LIMITED WARRANTIES IN SECTION 6 HEREOF ARE IN LIEU OF ALL OTHER 
WARRANTIES, EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, ANY 
IMPLIED WARRANTIES OF NON-INFRINGEMENT, MERCHANTABILITY OR FIT NESS 
FOR A PARTICULAR PURPOSE, EACH OF WHICH IS HEREBY DISCLAIMED. EXCEPT 
AS SET FORTH IN SECTION 6, THE SOFTWARE AND USER DOCUMENTATION ARE 
PROVIDED ON AN "AS-IS" BASIS.  
IN NO EVENT SHALL PCA OR DEALER (IF ANY) BE LIABLE FOR: (A) LOSS OF PROFITS, 
DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, PUNITIVE, CONSEQUENTIAL 
OR OTHER DAMAGES, EVEN IF PCA OR DEALER (IF ANY) HAS BEEN ADVISED OF THE 
POSSIBILITY OF SUCH DAMAGES; (B) ANY CLAIM AGAINST CUSTOMER BY ANY THIRD 

 



 

PARTY; OR (C) ANY DAMAGES CAUSED BY (1) DELAY IN DELIVERY OF THE SOFTWARE 
OR USER DOCUMENTATION UNDER THIS AGREEMENT; (2) THE PERFORMANCE OR NON 
PERFORMANCE OF THE SOFTWARE; (3) RESULTS FROM USE OF THE SOFTWARE OR 
USER DOCUMENTATION, INCLUDING, WITHOUT LIMITATION, MISTAKES, ERRORS, 
INAC CURACIES, FAILURES OR CUSTOMER'S INABILITY TO PROVIDE SERVICES TO 
THIRD PARTIES THROUGH USE OF THE SOFTWARE OR USER DOCUMENTATION; 
(4) CUSTOMER'S FAILURE TO PERFORM CUSTOMER'S RESPONSIBILI TIES; (5) PCA NOT 
PROVIDING UPDATES, BUG FIXES OR CORRECTIONS TO OR FOR ANY OF THE 
SOFTWARE OR USER DOCUMENTATION; (6) LABOR, EXPENSE OR MATERIALS 
NECESSARY TO REPAIR DAMAGE TO THE SOFTWARE OR USER DOCUMENTATION 
CAUSED BY (a) ACCIDENT, (b) NEGLI GENCE OR ABUSE BY CUSTOMER, (c) ACTS OF 
THIRD PERSONS INCLUDING, BUT NOT LIMITED TO, INSTALLATION, REPAIR, 
MAINTENANCE OR OTHER CORRECTIVE WORK RELATED TO ANY EQUIPMENT BEING 
USED, (d) CAUSES EXTERNAL TO THE SOFTWARE SUCH AS POWER FLUCTUATION AND 
FAILURES, OR (e) FLOODS, WINDSTORMS OR OTHER ACTS OF GOD. MOREOVER, IN NO 
EVENT SHALL PCA BE LIABLE FOR WARRANTIES, GUARANTEES, REPRESENTATIONS 
OR ANY OTHER UNDERSTAN DINGS BETWEEN CUSTOMER AND DEALER (IF ANY) 
RELATING TO THE SOFTWARE OR USER DOCUMENTATION. 
THIS AGREEMENT CONSTITUTES THE ENTIRE AND EXCLUSIVE AGREEMENT BETWEEN 
CUSTOMER AND PCA AND DEALER (IF ANY) WITH RESPECT TO THE SOFTWARE AND 
USER DOCUMENTATION TO BE FURNISHED HEREUNDER. IT IS A FINAL EXPRESSION OF 
THAT AGREEMENT AND UNDERSTANDING. IT SUPER SEDES ALL PRIOR 
COMMUNICATIONS BETWEEN THE PARTIES (INCLUDING ANY EVALUATION LICENSE 
AND ALL ORAL AND WRITTEN PROPOSALS). ORAL STATEMENTS MADE BY PCA'S OR 
DEALER'S (IF ANY) REPRESENTATIVES ABOUT THE SOFTWARE OR USER DOCUMEN 
TATION DO NOT CONSTITUTE REPRESENTATIONS OR WARRANTIES, SHALL NOT BE 
RELIED ON BY CUSTOMER, AND ARE NOT PART OF THIS AGREEMENT. 
 
1. LICENSE RESTRICTIONS  

(a) Except as expressly provided in this Agreement or as otherwise authorized in writing by PCA, 
Customer has no right to: (1) use, print, copy, display, reverse assemble, reverse engineer, 
translate or decompile the Software or User Documentation in whole or in part; (2) disclose, 
publish, release, sublicense or transfer to another person any Software or User Documentation; 
(3) reproduce the Software or User Documentation for the use or benefit of anyone other than 
Customer; or (4) modify any Software or User Documentation. All rights to the Software and 
User Documentation not expressly granted to Customer hereunder are retained by PCA. All 
copyrights and other proprietary rights except as expressed elsewhere in the Software or User 
Documentation and legal title thereto shall remain in PCA. Customer may use the Software at 
only one designated workstation at Customer's site at any given time. Customer may not transmit 
the Software electronically to any other workstation, computer, node or terminal device whether 
via a local area network, a wide area network, telecommunications transmission, the Internet or 
other means now known or hereafter created without prior written permission by PCA.  

(b) Customer acknowledges that this is a limited license for trial and evaluation purposes only. This 
limited license shall automatically terminate upon the earlier of: (1) ten executions of the 
Software on the computer on which it is installed; or (2) fifteen days after the installation of the 
Software. Thereafter, Customer may only use the Software and Documentation if it acquires a 
production license for the same.  
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2. TERM AND TERMINATION  

(a) This Agreement shall be in effect from the date Customer clicks the “I AGREE” icon below or 
installs, copies or otherwise uses the Software or User Documentation until: (1) it is terminated by 
Customer, by Dealer (if any) on behalf of Customer or PCA or by PCA as set forth herein; or 
(2) the limited trial and evaluation license terminates.  

(b) This Agreement may be terminated by PCA without cause upon 30 days' written notice or 
immediately upon notice to Customer if Customer breaches this Agreement or fails to comply 
with any of its terms or conditions. This Agreement may be terminated by Customer without 
cause at any time upon written notice to PCA.  

 
3. BACKUP AND REPLACEMENT COPIES  

Customer may make one copy of the Software for back-up and archival purposes only, provided 
PCA's copyright and other proprietary rights notices are included on such copy.  

 
4. PROTECTION AND SECURITY  

(a) Customer shall not provide or otherwise make available any of the Software or User 
Documentation in any form to any person other than employees of Customer with the need to 
know, without PCA's written permission. 

(b) All Software and User Documentation in Customer's possession including, without limitation, 
translations, compilations, back-up, and partial copies is the property of PCA. Upon termination 
of this Agreement for any reason, Customer shall immediately destroy all Software and User 
Documentation, including all media, and destroy any Software that has been copied onto other 
magnetic storage devices. Upon PCA’s request, Customer shall certify its compliance in writing 
with the foregoing to PCA. 

(c) Customer shall take appropriate action, by instruction, agreement or otherwise, with any persons 
permitted access to the Software or User Documentation, to enable Customer to satisfy its 
obligations under this Agreement with respect to use, copying, protection, and security of the 
same. 

(d) If PCA prevails in an action against Customer for breach of the provisions of this Section 4, 
Customer shall pay the reasonable attorneys' fees, costs, and expenses incurred by PCA in 
connection with such action in addition to any award of damages. 

 
5. CUSTOMER'S RESPONSIBILITIES  

The essential purpose of this Agreement is to provide Customer with limited use rights to the 
Software and User Documentation. Customer accepts full responsibility for: (a) selection of the 
Software and User Documentation to satisfy Customer's business needs and achieve Customer's 
intended results; (b) the use, set-up and installation of the Software and User Documentation; 
(c) all results obtained from use of the Software and User Documentation; and (d) the selection, 
use of, and results obtained from any other software, programming equipment or services used 
with the Software or User Documentation. 

 
6. LIMITED WARRANTIES  

PCA and Dealer (if any) warrants to Customer that: (a) PCA and Dealer (if any) has title to the 
Software and User Documentation and/or the right to grant Customer the rights granted hereunder; 
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(b) the Software and User Documentation provided hereunder is PCA's most current production 
version thereof; and (c) the copy of the Software provided hereunder is an accurate reproduction 
of the original from which it was made.  

 
7. LIMITATION OF REMEDY  

(a) PCA AND DEALER (IF ANY) HAS NO LIABILITY UNDER THIS AGREEMENT. 
CUSTOMER'S EXCLUSIVE REMEDY FOR DAMAGES DUE TO PERFORMANCE OR 
NONPERFORMANCE OF ANY SOFTWARE OR USER DOCUMENTATION, PCA, 
DEALER (IF ANY), OR ANY OTHER CAUSE WHATSO EVER, AND REGARDLESS 
OF THE FORM OF ACTION, WHETHER IN CONTRACT OR IN TORT, INCLUDING 
NEGLIGENCE, SHALL BE LIMITED TO CUSTOMER STOPPING ALL USE OF THE 
SOFTWARE AND USER DOCUMENTATION AND RETURNING THE SAME TO PCA.  

(b) NEITHER PCA NOR DEALER (IF ANY) IS AN INSURER WITH REGARD TO THE 
PERFORMANCE OF THE SOFTWARE OR USER DOCUMENTATION. THE TERMS 
OF THIS AGREEMENT, INCLUDING, BUT NOT LIMITED TO, THE LIMITED 
WARRANTIES, AND THE LIMITATION OF LIABILITY AND REMEDY, ARE A 
REFLECTION OF THE RISKS ASSUMED BY THE PARTIES. IN ORDER TO OBTAIN 
THE SOFTWARE AND USER DOCUMENTATION FROM PCA OR DEALER (IF ANY), 
CUSTOMER HEREBY ASSUMES THE RISKS FOR (1) ALL LIABILITIES 
DISCLAIMED BY PCA AND DEALER (IF ANY) ON THE FACE HEREOF; AND 
(2) ALL ACTUAL OR ALLEGED DAMAGES IN CONNECTION WITH THE USE OF 
THE SOFTWARE AND USER DOCUMENTATION. THE ESSENTIAL PURPOSE OF 
THE LIMITED REMEDY PROVIDED CUSTOMER HEREUNDER IS TO ALLOCATE 
THE RISKS AS PROVIDED ABOVE. 

 
8. U.S. GOVERNMENT RESTRICTED RIGHTS  

This commercial computer software and commercial computer software documentation were 
developed exclusively at private expense by Portland Cement Association, 5420 Old Orchard 
Road, Skokie, Illinois, 60077. U.S. Government rights to use, modify, release, reproduce, perform, 
display or disclose this computer software and computer software documentation are subject to 
the restrictions of DFARS 227.7202-1(a) (June 1995) and DFARS 227.7202-3(a) (June 1995), or 
the Restricted Rights provisions of FAR 52.227-14 (June 1987) and FAR 52.227-19 (June 1987), 
as applicable. 

 
9. GENERAL  

(a) No action arising out of any claimed breach of this Agreement or transactions under this 
Agreement may be brought by Customer more than two years after the cause of such action has 
arisen. 

(b) Customer may not assign, sell, sublicense or otherwise transfer this Agreement, the license granted 
herein or the Software or User Documentation by operation of law or otherwise without the prior 
written consent of PCA. Any attempt to do any of the foregoing without PCA’s consent is void.  

(c) Customer acknowledges that the Software, User Documentation and other proprietary information 
and materials of PCA are unique and that, if Customer breaches this Agreement, PCA may not 
have an adequate remedy at law and PCA may enforce its rights hereunder by an action for 
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damages and/or injunctive or other equitable relief without the necessity of proving actual damage 
or posting a bond therefor. 

(D) THE RIGHTS AND OBLIGATIONS UNDER THIS AGREEMENT SHALL NOT BE 
GOVERNED BY THE UNITED NATIONS CONVENTION ON CONTRACTS FOR THE 
INTERNATIONAL SALE OF GOODS, THE APPLICATION OF WHICH IS EXPRESSLY 
EXCLUDED, BUT SUCH RIGHTS AND OBLIGATIONS SHALL INSTEAD BE GOVERNED 
BY THE LAWS OF THE STATE OF ILLINOIS, APPLICABLE TO CONTRACTS ENTERED 
INTO AND PERFORMED ENTIRELY WITHIN THE STATE OF ILLINOIS AND 
APPLICABLE FEDERAL (U.S.) LAWS. UCITA SHALL NOT APPLY TO THIS 
AGREEMENT.  

(E) THIS AGREEMENT SHALL BE TREATED AS THOUGH IT WERE EXECUTED IN THE 
COUNTY OF COOK, STATE OF ILLINOIS, AND WAS TO HAVE BEEN PERFORMED IN 
THE COUNTY OF COOK, STATE OF ILLINOIS. ANY ACTION RE LATING TO THIS 
AGREEMENT SHALL BE INSTITUTED AND PROSECUTED IN A COURT LOCATED IN 
COOK COUNTY, ILLINOIS. CUSTOMER SPECIFICALLY CONSENTS TO 
EXTRATERRITORIAL SERVICE OF PROCESS.  

(f) Except as prohibited elsewhere in this Agreement, this Agreement shall be binding upon and inure 
to the benefit of the personal and legal representatives, permitted successors, and permitted 
assigns of the parties hereto.  

(g) All notices, demands, consents or requests that may be or are required to be given by any party to 
another party shall be in writing. All notices, demands, consents or requests given by the parties 
hereto shall be sent either by U.S. certified mail, postage prepaid or by an overnight international 
delivery service, addressed to the respective parties. Notices, demands, consents or requests 
served as set forth herein shall be deemed sufficiently served or given at the time of receipt 
thereof.  

(h) The various rights, options, elections, powers, and remedies of a party or parties to this Agreement 
shall be construed as cumulative and no one of them exclusive of any others or of any other legal 
or equitable remedy that said party or parties might otherwise have in the event of breach or 
default in the terms hereof. The exercise of one right or remedy by a party or parties shall not in 
any way impair its rights to any other right or remedy until all obligations imposed on a party or 
parties have been fully performed. 

(i) No waiver by Customer, PCA or Dealer (if any) of any breach, provision, or default by the other 
shall be deemed a waiver of any other breach, provision or default.  

(j) The parties hereto, and each of them, agree that the terms of this Agreement shall be given 
a neutral interpretation and any ambiguity or uncertainty herein should not be construed against 
any party hereto. 

(k) If any provision of this Agreement or portion thereof is held to be unenforceable or invalid by any 
court or competent jurisdiction, such decision shall not have the effect of invalidating or voiding 
the remainder of this Agreement, it being the intent and agreement of the parties that this 
Agreement shall be deemed amended by modifying such provision to the extent necessary to 
render it enforceable and valid while preserving its intent or, if such modification is not possible, 
by substituting therefor another provision that is enforceable and valid so as to materially 
effectuate the parties’ intent.  

(l) Except as set forth herein, this Agreement may be modified or amended only by a written 
instrument signed by a duly authorized representative of PCA and Customer. 
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PORTLAND CEMENT ASSOCIATION 
SOFTWARE LICENSE AGREEMENT 

 
BY CLICKING THE “I AGREE” BELOW, OR BY INSTALLING, COPYING, OR OTHERWISE 
USING THE SOFTWARE OR USER DOCUMENTATION, YOU AGREE TO BE BOUND BY THE 
TERMS OF THIS AGREEMENT, INCLUDING, BUT NOT LIMITED TO, THE WARRANTY 
DISCLAIMERS, LIMITATIONS OF LIABILITY AND TERMINATION PROVISIONS BELOW. IF 
YOU DO NOT AGREE TO THE TERMS OF THIS AGREEMENT, DO NOT INSTALL OR USE 
THE SOFTWARE OR USER DOCUMENTATION, EXIT THIS APPLICATION NOW AND 
RETURN THE SOFTWARE AND USER DOCUMENTATION TO PCA FOR A FULL REFUND 
WITHIN THIRTY DAYS AFTER YOUR RECEIPT OF THE SOFTWARE AND USER 
DOCUMENTATION. 
PORTLAND CEMENT ASSOCIATION, 5420 OLD ORCHARD ROAD, SKOKIE, ILLINOIS 60077 
(HEREAFTER PCA), GRANTS THE CUSTOMER A PERSONAL, NONEXCLUSIVE, LIMITED, 
NONTRANSFERABLE LICENSE TO USE THIS SOFTWARE AND USER DOCUMENTATION 
IN ACCORDANCE WITH THE TERMS AND CONDITIONS OF THIS AGREEMENT. 
SOFTWARE AND USER DOCUMENTATION IS SUPPLIED TO CUSTOMER EITHER BY PCA 
DIRECTLY OR THROUGH AN AUTHORIZED DEALER OF PCA (HEREAFTER DEALER). 
WHILE PCA HAS TAKEN PRECAUTIONS TO ASSURE THE CORRECTNESS OF THE 
ANALYTICAL SOLUTION AND DESIGN TECHNIQUES USED IN THIS SOFTWARE, IT 
CANNOT AND DOES NOT GUARANTEE ITS PERFORMANCE, NOR CAN IT OR DOES IT 
BEAR ANY RESPONSIBILITY FOR DEFECTS OR FAILURES IN STRUCTURES IN 
CONNECTION WITH WHICH THIS SOFTWARE IS USED. DEALER (IF ANY) HAS NOT 
PARTICIPATED IN THE DESIGN OR DEVELOPMENT OF THIS SOFTWARE AND NEITHER 
GUARANTEES THE PERFORMANCE OF THE SOFTWARE NOR BEARS ANY 
RESPONSIBILITY FOR DEFECTS OR FAILURES IN STRUCTURES IN CONNECTION WITH 
WHICH THIS SOFTWARE IS USED. 
PCA AND DEALER (IF ANY) EXPRESSLY DISCLAIM ANY WARRANTY THAT: (A) THE 
FUNCTIONS CONTAINED IN THE SOFTWARE WILL MEET THE REQUIREMENTS OF 
CUSTOMER OR OPERATE IN COMBINATIONS THAT MAY BE SELECTED FOR USE BY 
CUSTOMER; (B) THE OPERATION OF THE SOFTWARE WILL BE FREE OF ALL "BUGS" OR 
PROGRAM ERRORS; OR (C) THE SOFTWARE CONFORMS TO ANY PERFORMANCE 
SPECIFICATIONS. CUSTOMER ACKNOWLEDGES THAT PCA IS UNDER NO OBLIGATION 
TO PROVIDE ANY SUPPORT, UPDATES, BUG FIXES OR ERROR CORRECTIONS TO OR FOR 
THE SOFTWARE OR USER DOCUMENTATION.  
THE LIMITED WARRANTIES IN SECTION 7 HEREOF ARE IN LIEU OF ALL OTHER 
WARRANTIES, EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, ANY 
IMPLIED WARRANTIES OF NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS 
FOR A PARTICULAR PURPOSE, EACH OF WHICH IS HEREBY DISCLAIMED. EXCEPT 
AS SET FORTH IN SECTION 7, THE SOFTWARE AND USER DOCUMENTATION ARE 
PROVIDED ON AN "AS-IS" BASIS.  
IN NO EVENT SHALL PCA OR DEALER (IF ANY) BE LIABLE FOR: (A) LOSS OF 
PROFITS, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, PUNITIVE, 
CONSEQUENTIAL OR OTHER DAMAGES, EVEN IF PCA OR DEALER (IF ANY) HAS 
BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES; (B) ANY CLAIM AGAINST 
CUSTOMER BY ANY THIRD PARTY EXCEPT AS PROVIDED IN SECTION 8 ENTITLED 
"INFRINGEMENT"; OR (C) ANY DAMAGES CAUSED BY (1) DELAY IN DELIVERY OF 
THE SOFTWARE OR USER DOCUMENTATION UNDER THIS AGREEMENT; (2) THE 
PERFORMANCE OR NONPERFORMANCE OF THE SOFTWARE; (3) RESULTS FROM 
USE OF THE SOFTWARE OR USER DOCUMENTATION, INCLUDING, WITHOUT 
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LIMITATION, MISTAKES, ERRORS, INACCURACIES, FAILURES OR CUSTOMER'S 
INABILITY TO PROVIDE SERVICES TO THIRD PARTIES THROUGH USE OF THE 
SOFTWARE OR USER DOCUMENTATION; (4) CUSTOMER'S FAILURE TO PERFORM 
CUSTOMER'S RESPONSIBILITIES; (5) PCA NOT PROVIDING UPDATES, BUG FIXES OR 
CORRECTIONS TO OR FOR ANY OF THE SOFTWARE OR USER DOCUMENTATION; (6) 
LABOR, EXPENSE OR MATERIALS NECESSARY TO REPAIR DAMAGE TO THE 
SOFTWARE OR USER DOCUMENTATION CAUSED BY (a) ACCIDENT, (b) NEGLIGENCE 
OR ABUSE BY CUSTOMER, (c) ACTS OF THIRD PERSONS INCLUDING, BUT NOT 
LIMITED TO, INSTALLATION, REPAIR, MAINTENANCE OR OTHER CORRECTIVE 
WORK RELATED TO ANY EQUIPMENT BEING USED, (d) CAUSES EXTERNAL TO THE 
SOFTWARE SUCH AS POWER FLUCTUATION AND FAILURES, OR (e) FLOODS, 
WINDSTORMS OR OTHER ACTS OF GOD. MOREOVER, IN NO EVENT SHALL PCA BE 
LIABLE FOR WARRANTIES, GUARANTEES, REPRESENTATIONS OR ANY OTHER 
UNDERSTANDINGS BETWEEN CUSTOMER AND DEALER (IF ANY) RELATING TO THE 
SOFTWARE OR USER DOCUMENTATION. 
THIS AGREEMENT CONSTITUTES THE ENTIRE AND EXCLUSIVE AGREEMENT BETWEEN 
CUSTOMER AND PCA AND DEALER (IF ANY) WITH RESPECT TO THE SOFTWARE AND 
USER DOCUMENTATION TO BE FURNISHED HEREUNDER. IT IS A FINAL EXPRESSION OF 
THAT AGREEMENT AND UNDERSTANDING. IT SUPERSEDES ALL PRIOR 
COMMUNICATIONS BETWEEN THE PARTIES (INCLUDING ANY EVALUATION LICENSE 
AND ALL ORAL AND WRITTEN PROPOSALS). ORAL STATEMENTS MADE BY PCA'S OR 
DEALER'S (IF ANY) REPRESENTATIVES ABOUT THE SOFTWARE OR USER 
DOCUMENTATION DO NOT CONSTITUTE REPRESENTATIONS OR WARRANTIES, SHALL 
NOT BE RELIED ON BY CUSTOMER, AND ARE NOT PART OF THIS AGREEMENT. 
 
1. LICENSE RESTRICTIONS  

(a) Except as expressly provided in this Agreement or as otherwise authorized in writing by PCA, 
Customer has no right to: (1) use, print, copy, display, reverse assemble, reverse engineer, 
translate or decompile the Software or User Documentation in whole or in part; (2) disclose, 
publish, release, sublicense or transfer to another person any Software or User Documentation; (3) 
reproduce the Software or User Documentation for the use or benefit of anyone other than 
Customer; or (4) modify any Software or User Documentation. All rights to the Software and 
User Documentation not expressly granted to Customer hereunder are retained by PCA. All 
copyrights and other proprietary rights except as expressed elsewhere in the Software or User 
Documentation and legal title thereto shall remain in PCA. Customer may use the Software at 
only one designated workstation at Customer's site at any given time. Customer may not transmit 
the Software electronically to any other workstation, computer, node or terminal device whether 
via a local area network, a wide area network, telecommunications transmission, the Internet or 
other means now known or hereafter created without prior written permission by PCA.  

(B) CUSTOMER ACKNOWLEDGES THAT THE REGISTRATION PROCESS FOR THE 
SOFTWARE RESULTS IN THE GENERATION OF A UNIQUE LICENSE KEY AND 
ACTIVATION CODE PAIR. ONCE THE LICENSE KEY AND ACTIVATION CODE 
ARE ENTERED DURING THE INSTALLATION PROCESS, THE SOFTWARE WILL 
ONLY WORK ON THE COMPUTER ON WHICH THE SOFTWARE IS INITIALLY 
INSTALLED. IF YOU NEED TO DEINSTALL THE SOFTWARE AND REINSTALL 
THE SOFTWARE ON A DIFFERENT COMPUTER, YOU MUST CONTACT PCA TO 
OBTAIN THE NECESSARY REINSTALLATION PROCEDURES.  

 

License Agreements  ix 



 

2. CHARGES AND PAYMENTS  
All payments for the Software and User Documentation shall be made to either PCA or Dealer (if 
any), as appropriate. 

 
3. TERM AND TERMINATION  

(a) This Agreement shall be in effect from the date Customer clicks the “I AGREE” below or installs, 
copies or otherwise uses the Software or User Documentation until it is terminated by Customer, 
by Dealer (if any) on behalf of Customer or PCA or by PCA as set forth herein.  

(b) This Agreement may be terminated by PCA without cause upon 30 days' written notice or 
immediately upon notice to Customer if Customer breaches this Agreement or fails to comply 
with any of its terms or conditions. This Agreement may be terminated by Customer without 
cause at any time upon written notice to PCA.  

 
4. BACKUP AND REPLACEMENT COPIES  

Customer may make one copy of the Software for back-up and archival purposes only, provided 
PCA's copyright and other proprietary rights notices are included on such copy.  

 
5. PROTECTION AND SECURITY  

(a) Customer shall not provide or otherwise make available any of the Software or User Documentation 
in any form to any person other than employees of Customer with the need to know, without 
PCA's written permission. 

(b) All Software and User Documentation in Customer's possession including, without limitation, 
translations, compilations, back-up, and partial copies is the property of PCA. Upon termination 
of this Agreement for any reason, Customer shall immediately destroy all Software and User 
Documentation, including all media, and destroy any Software that has been copied onto other 
magnetic storage devices. Upon PCA’s request, Customer shall certify its compliance in writing 
with the foregoing to PCA. 

(c) Customer shall take appropriate action, by instruction, agreement or otherwise, with any persons 
permitted access to the Software or User Documentation, to enable Customer to satisfy its 
obligations under this Agreement with respect to use, copying, protection, and security of the 
same. 

(d) If PCA prevails in an action against Customer for breach of the provisions of this Section 5, 
Customer shall pay the reasonable attorneys' fees, costs, and expenses incurred by PCA in 
connection with such action in addition to any award of damages. 

 
6. CUSTOMER'S RESPONSIBILITIES  

The essential purpose of this Agreement is to provide Customer with limited use rights to the 
Software and User Documentation. Customer accepts full responsibility for: (a) selection of the 
Software and User Documentation to satisfy Customer's business needs and achieve Customer's 
intended results; (b) the use, set-up and installation of the Software and User Documentation; (c) 
all results obtained from use of the Software and User Documentation; and (d) the selection, use 
of, and results obtained from any other software, programming equipment or services used with 
the Software or User Documentation. 
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7. LIMITED WARRANTIES  
PCA and Dealer (if any) warrants to Customer that: (a) PCA and Dealer (if any) has title to the 
Software and User Documentation and/or the right to grant Customer the rights granted hereunder; 
(b) the Software and User Documentation provided hereunder is PCA's most current production 
version thereof; and (c) the copy of the Software provided hereunder is an accurate reproduction 
of the original from which it was made.  

 
8. INFRINGEMENT  
(a) PCA shall defend Customer against a claim that the Software or User Documentation furnished and 
used within the scope of the license granted hereunder infringes a U.S. patent or U.S. registered 
copyright of any third party that was issued or registered, as applicable, as of the date Customer clicked 
the “I AGREE” below or installed, copied or otherwise began using the Software or User 
Documentation, and PCA shall pay resulting costs, damages, and attorneys' fees finally awarded, 
subject to the limitation of liability set forth in Section 9 entitled "Limitation of Remedy," provided that: 

1. Customer promptly notifies PCA in writing of the claim. 
2. PCA has sole control of the defense and all related settlement negotiations.  
3. If such claim has occurred or in PCA's opinion is likely to occur, Customer shall permit PCA at its 
sole option and expense either to procure for Customer the right to continue using the Software or 
User Documentation or to replace or modify the same so that it becomes noninfringing. If neither of 
the foregoing alternatives is reasonably available in PCA's sole judgment, Customer shall, on one 
month's written notice from PCA, return to PCA the Software and User Documentation and all 
copies thereof.  

(b) PCA shall have no obligation to defend Customer or to pay costs, damages or attorneys' fees for any 
claim based upon (1) use of other than a current unaltered release of the Software or User 
Documentation, or (2) the combination, operation or use of any Software or User Documentation 
furnished hereunder with any other software, documentation or data if such infringement would have 
been avoided but for the combination, operation or use of the Software or User Documentation with 
other software, documentation or data. 
(c) The foregoing states the entire obligation of PCA and Customer’s sole remedy with respect to 
infringement matters relating to the Software and User Documentation. 
 
9. LIMITATION OF REMEDY  

(a) PCA'S AND DEALER'S (IF ANY) ENTIRE LIABILITY AND CUSTOMER'S EXCLUSIVE 
REMEDY FOR DAMAGES DUE TO PERFORMANCE OR NONPERFORMANCE OF 
ANY SOFTWARE OR USER DOCUMENTATION, PCA, DEALER (IF ANY), OR ANY 
OTHER CAUSE WHATSOEVER, AND REGARDLESS OF THE FORM OF ACTION, 
WHETHER IN CONTRACT OR IN TORT, INCLUDING NEGLIGENCE, SHALL BE 
LIMITED TO THE AMOUNT PAID TO PCA OR DEALER (IF ANY) FOR THE 
SOFTWARE AND USER DOCUMENTATION.  

(b) NEITHER PCA NOR DEALER (IF ANY) IS AN INSURER WITH REGARD TO THE 
PERFORMANCE OF THE SOFTWARE OR USER DOCUMENTATION. THE TERMS OF 
THIS AGREEMENT, INCLUDING, BUT NOT LIMITED TO, THE LIMITED 
WARRANTIES, AND THE LIMITATION OF LIABILITY AND REMEDY, ARE A 
REFLECTION OF THE RISKS ASSUMED BY THE PARTIES. IN ORDER TO OBTAIN 
THE SOFTWARE AND USER DOCUMENTATION FROM PCA OR DEALER (IF ANY), 
CUSTOMER HEREBY ASSUMES THE RISKS FOR (1) ALL LIABILITIES DISCLAIMED 
BY PCA AND DEALER (IF ANY) ON THE FACE HEREOF; AND (2) ALL ACTUAL OR 
ALLEGED DAMAGES IN EXCESS OF THE AMOUNT OF THE LIMITED REMEDY 
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PROVIDED HEREUNDER. THE ESSENTIAL PURPOSE OF THE LIMITED REMEDY 
PROVIDED CUSTOMER HEREUNDER IS TO ALLOCATE THE RISKS AS PROVIDED 
ABOVE. 

 
10. U.S. GOVERNMENT RESTRICTED RIGHTS  

This commercial computer software and commercial computer software documentation were 
developed exclusively at private expense by Portland Cement Association, 5420 Old Orchard 
Road, Skokie, Illinois 60077. U.S. Government rights to use, modify, release, reproduce, 
perform, display or disclose this computer software and computer software documentation are 
subject to the restrictions of DFARS 227.7202-1(a) (June 1995) and DFARS 227.7202-3(a) 
(June 1995), or the Restricted Rights provisions of FAR 52.227-14 (June 1987) and FAR 
52.227-19 (June 1987), as applicable. 

 
11. GENERAL  

(a) No action arising out of any claimed breach of this Agreement or transactions under this Agreement 
may be brought by Customer more than two years after the cause of such action has arisen. 

(b) Customer may not assign, sell, sublicense or otherwise transfer this Agreement, the license 
granted herein or the Software or User Documentation by operation of law or otherwise without 
the prior written consent of PCA. Any attempt to do any of the foregoing without PCA’s consent 
is void.  

(c) Customer acknowledges that the Software, User Documentation and other proprietary information 
and materials of PCA are unique and that, if Customer breaches this Agreement, PCA may not 
have an adequate remedy at law and PCA may enforce its rights hereunder by an action for 
damages and/or injunctive or other equitable relief without the necessity of proving actual damage 
or posting a bond therefor. 

(D) THE RIGHTS AND OBLIGATIONS UNDER THIS AGREEMENT SHALL NOT BE 
GOVERNED BY THE UNITED NATIONS CONVENTION ON CONTRACTS FOR THE 
INTERNATIONAL SALE OF GOODS, THE APPLICATION OF WHICH IS EXPRESSLY 
EXCLUDED, BUT SUCH RIGHTS AND OBLIGATIONS SHALL INSTEAD BE GOVERNED 
BY THE LAWS OF THE STATE OF ILLINOIS, APPLICABLE TO CONTRACTS ENTERED 
INTO AND PERFORMED ENTIRELY WITHIN THE STATE OF ILLINOIS AND 
APPLICABLE FEDERAL (U.S.) LAWS. UCITA SHALL NOT APPLY TO THIS 
AGREEMENT.  

(E) THIS AGREEMENT SHALL BE TREATED AS THOUGH IT WERE EXECUTED IN THE 
COUNTY OF COOK, STATE OF ILLINOIS, AND WAS TO HAVE BEEN PERFORMED IN 
THE COUNTY OF COOK, STATE OF ILLINOIS. ANY ACTION RELATING TO THIS 
AGREEMENT SHALL BE INSTITUTED AND PROSECUTED IN A COURT LOCATED IN 
COOK COUNTY, ILLINOIS. CUSTOMER SPECIFICALLY CONSENTS TO 
EXTRATERRITORIAL SERVICE OF PROCESS.  

(f) Except as prohibited elsewhere in this Agreement, this Agreement shall be binding upon and inure to 
the benefit of the personal and legal representatives, permitted successors, and permitted assigns 
of the parties hereto.  
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(g) All notices, demands, consents or requests that may be or are required to be given by any party to 
another party shall be in writing. All notices, demands, consents or requests given by the parties 
hereto shall be sent either by U.S. certified mail, postage prepaid or by an overnight international 
delivery service, addressed to the respective parties. Notices, demands, consents or requests 
served as set forth herein shall be deemed sufficiently served or given at the time of receipt 
thereof.  

(h) The various rights, options, elections, powers, and remedies of a party or parties to this 
Agreement shall be construed as cumulative and no one of them exclusive of any others or of any 
other legal or equitable remedy that said party or parties might otherwise have in the event of 
breach or default in the terms hereof. The exercise of one right or remedy by a party or parties 
shall not in any way impair its rights to any other right or remedy until all obligations imposed on 
a party or parties have been fully performed. 

(i) No waiver by Customer, PCA or Dealer (if any) of any breach, provision, or default by the other 
shall be deemed a waiver of any other breach, provision or default.  

(j) The parties hereto, and each of them, agree that the terms of this Agreement shall be given a neutral 
interpretation and any ambiguity or uncertainty herein should not be construed against any party 
hereto. 

(k) If any provision of this Agreement or portion thereof is held to be unenforceable or invalid by any 
court or competent jurisdiction, such decision shall not have the effect of invalidating or voiding 
the remainder of this Agreement, it being the intent and agreement of the parties that this 
Agreement shall be deemed amended by modifying such provision to the extent necessary to 
render it enforceable and valid while preserving its intent or, if such modification is not possible, 
by substituting therefor another provision that is enforceable and valid so as to materially 
effectuate the parties’ intent.  

Except as set forth herein, this Agreement may be modified or amended only by a written instrument 
signed by a duly authorized representative of PCA and Customer. 
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Chapter 1 
Introduction 

Terms 
The following terms are used throughout this manual. A brief explanation is given 
to help familiarize you with them. 

Windows refers to the Microsoft Windows environment version 3.1 or 
higher. 
 

[ ] indicates metric equivalent 
 

Click on means to position the cursor on top of a designated item or 
location and press and release the left-mouse button (unless 
instructed to use the right-mouse button). 
 

Double-click on means to position the cursor on top of a designated item or 
location and press and release the left-mouse button twice in 
quick succession. 
 

Marquee select means to depress the mouse button and continue to hold it 
down while moving the mouse. As you drag the mouse, a 
rectangle (known as a marquee) follows the cursor. Release 
the mouse button and the area inside the marquee is selected. 

 



 

Conventions 
Various styles of text and layout have been used in this manual to help 
differentiate between different kinds of information. The styles and layout are 
explained below… 

Italic indicates a glossary item, or emphasizes a given word or 
phrase. 

Bold All bold typeface makes reference to either a menu or a 
menu item command such as File or Save, or a tab such as 
Description or Grid 

Mono-space indicates something you should enter with the keyboard. For 
example type “c:\*.txt”. 

KEY + KEY indicates a key combination. The plus sign indicates that you 
should press and hold the first key while pressing the second 
key, then release both keys. For example, “ALT + F” 
indicates that you should press the “ALT” key and hold it 
while you press the “F” key. then release both keys. 

SMALL CAPS Indicates the name of an object such as a dialog box or a 
dialog box component. For example, the OPEN dialog box or 
the CANCEL or MODIFY buttons. 

System requirements 
To use pcaMats, a personal computer with one of the following operating systems 
is required…  

• Microsoft Windows 98 or later 

• Windows ME  

• Windows XP  

• Windows NT  

• Windows 2000 Server.  

Minimum Requirements  
• 32 MB of RAM  

• CD-ROM drive  
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• 50 MB free space on hard drive  

• A mouse or other pointing device  

Recommended Options  
A printer supported by one of the operating systems listed above.  

Program Capacity 
• 255 X-grid lines  

• 255 Y-grid lines  

• 255 Thickness definitions  

• 255 Concrete definitions  

• 255 Soil definitions  

• 255 Nodal spring definitions  

• 255 Slaved nodes definitions  

• 255 Pile definitions  

• 255 Concentrated load definitions per load case  

• 255 Surface load definitions per load case  

• 255 Load combinations  

• Approximately 10,000 nodes and 10,000 elements  

With the minimum required RAM memory of 32MB, problems with 2,500 
elements and 2601 nodes (7803 equations) were solved. Depending on the 
available amount of RAM memory and hard disk space, larger problems may be 
solved. 
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Installing pcaMats 
1. If you have the installation disk please insert it into the CD drive and proceed 

to step 2. If you do not have the installation disk but downloaded the 
installation file from our website, please run the file and proceed to step 3. 

2. If the installation does not start automatically after inserting the installation 
disk to the CD drive then please run the file install.exe from the installation 
disk and proceed to step 3. If the installation starts automatically then please 
follow the instructions on the screen. You may be asked which product you 
want to install if you received pcaMats together with other software from 
pcaStructurePoint. 

3. The installation process starts by displaying the following window (Figure 1-
1). Please read all the information. Then press the NEXT button. This will 
continue the installation process by installing license manager, an evaluation 
license, and the application software. 

 
Figure 1-1. Beginning of the installation 

4. The first step of the application installation process is to review the software 
license agreement as shown in Figure 1-2. Please read all the information 
carefully. Press the I AGREE button to confirm that you have read and agreed 
with it. This will continue the installation. If you do not agree with the license 
agreement press the I DO NOT AGREE button. This will stop the installation. 
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Figure 1-2. License agreement 

5. If you continue the installation then please read the latest information of the 
software included in the readme file (Figure 1-3). Having read all the 
information press the NEXT button. 

 
Figure 1-3. Readme file 

6. In the next step please provide the user’s name and company. Press next when 
you are ready to proceed. 

Introduction  1-5 



 

 
Figure 1-4. Registration information 

7. The next setup is to decide the directory where pcaMats is to be installed as 
shown in Figure 1-5. The default one is C:\Program Files\PCA\pcaMats. 
You may press the BROWSE button to locate the directory. If the directory 
does not exist, the setup program will create it. Press the NEXT button to go to 
the next step. 

 
Figure 1-5. Choose Destination Location 

8. The next step is to enter the group name as shown in Figure 1-6. Windows 
will use this name in the Start/Programs menu. Press the NEXT button to go to 
the next step. 
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Figure 1-6. Select Program Manager Group 

9. After all the previous steps are completed, press the NEXT button as shown in 
Figure 1-7 to start the installation. 

 
Figure 1-7. Start Installation 

10. During the installation a window as in Fig. 1-8 shows the progress as files are 
copied to your hard drive. 
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Figure 1-8. Installation progress 

11. After the installation is completed, a dialog box similar to Figure 1-9 is shown. 
Press the FINISH button to finish the installation. 

 
Figure 1-9. Installation Complete 

Purchasing and Licensing Process 

Licensing Model 
By default, each pcaStructurePoint software application comes in an Evaluation 
mode. This means that initially our products can be used for a limited time of 15 
days. If the user decides to purchase the software license, and completes the 
purchase, pcaStructurePoint will provide a License Code. By entering this code, 
user will activate the software license. Once the software license is activated the 
application will no longer have restrictions limiting the time of operation. 
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Evaluation Mode 
This is the default mode of the license. In this licensing scheme, users are granted 
limited rights to use our full-featured software. The only visible difference 
between the evaluation version and the licensed version is an additional start-up 
dialog box as shown in Figure 1-8. It gives a choice of buying the software, 
entering the activation code or running the application in the evaluation mode by 
pressing the EVALUATE button. Evaluation mode is available for a limited time 
only. By default, pcaStructurePoint software applications come with 15 days. That 
means, from the day of installation, a user can evaluate the software for the next 15 
days. After this time, user will either obtain a License, or uninstall the application. 

Note: Any tampering with system clock or evaluation license file will render 
the software useless. 

 
Figure 1-8. Start-up Dialog Box 

How to Purchase 
You may purchase the license on-line at www.pcaStructurePoint.com or by calling 
our Sales Department at 847-972-9042. To buy on-line you may press BUY NOW 
button, which will run your default web browser and open the product web page 
where you will be able to complete the transaction. 

Licensing Activation 
After the purchase is completed, pcaStructurePoint will generate a unique 
Activation Code based on the product ID and the locking code, which is derived 
from the unique hardware-id of the user’s computer. Each License is associated 
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with the particular PC in which user has installed the pcaStructurePoint software. 
This implies that the activation-code will not work on any other PC. You can 
transfer the license to another PC by contacting pcaStructurePoint for the transfer 
procedures. 

To activate the license press the LICENSE ACTIVATION button in the start-up dialog 
box. This will bring a window as in Figure 1-9, which shows three license 
activation methods.  

 
Figure 1-9. License activation methods 

If you have already received the license code you may choose ENTER LICENSE 
CODE and then press the NEXT button. A window (Figure 1-9) will pop up where 
you will be able to type in the license code. However, in order to avoid mistyping 
we advise to use copy and paste feature instead of typing the code. 
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Figure 1-9. Enter license code 

The license code can also be extracted from a file. To do that press the BROWSE 
button  and open the file in which the license code is stored using the open 
window (Figure 1-10). 

 
Figure 1-10. Open activation file 

If the entered code is correct the license will be activated and window as in Figure 
1-11 will show. When you press the FINISH button the license activation will be 
completed. 
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Figure 1-11. Activation completion 

If you do not have the license code you may chose either TELEPHONE or E-MAIL 
method, whichever is more convenient for you. Please note that for E-MAIL 
method you need to have the Internet connection and a default mailer configured 
in your system. 

Activation by Phone 
If the telephone method was chosen to activate the license the following screen 
appears (Figure 1-12). It shows the product ID and the Locking Code.  

 
Figure 1-12. Activation by phone 
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This information is needed when you make a phone call at 847-966-4357 (HELP) 
to obtain the license. You will be asked to provide information about yourself in 
order to verify that you have purchased the license. 

Activation by E-mail 
If the e-mail method was chosen to activate the license a screen (Figure 1-13) will 
show prompting you to provide information about yourself. When you type in all 
the information press the SEND E-MAIL button and it will be automatically e-
mailed to us together with the product ID and the Locking Code. After the 
information is verified the license code will be generated and e-mailed back to you.  

 
Figure 1-13. Activation by e-mail 

After you receive it you may enter it by pressing the LICENSE ACTIVATION button 
in the start up dialog box (Figure 1-8) and choosing ENTER LICENSE CODE option. . 
If the entered code is correct, the license will be activated and window as in Figure 
1-11 will show. When you press the FINISH button the license activation will be 
completed. 
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Chapter 2 
Method of Solution 

pcaMats uses the Finite Element Method for the structural modeling and analysis 
of reinforced concrete slab systems or mat foundations subject to static loading 
conditions.  

The slab is idealized as a mesh of rectangular elements interconnected only at the 
corner nodes. The same mesh applies to the underlying soil with the soil stiffness 
concentrated at the nodes. Slabs of irregular geometry should be idealized to 
conform to a geometry with rectangular boundaries. Even though slab and soil 
properties can vary from one element to another, they are assumed uniform within 
each element.  

Three degrees of freedom exist at each node: vertical deflection and two rotations 
about the two rectangular axes. An external load can exist in the direction of each 
of the above deformations, i.e., a vertical force and two moments about the 
Cartesian axes. The internal stress resultants are related to the degrees of freedom 
of an element.  

The Global Coordinate system 
The mid-surface of the slab lies in the XY plane of the right-handed XYZ 
rectangular coordinate system shown in Figure 2-1. The slab thickness is measured 
in the direction of the Z-axis. Looking at the display monitor, the origin of the 
coordinate system is located in the bottom left corner of the screen. The positive 
X-axis points to the right, the positive Y-axis points upward towards the top of the 
monitor, and the positive Z-axis points out of the screen. Thus, the XY plane is 
defined as being the plane of the display monitor. 
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Figure 2-1. The Global Coordinate System 

Mesh Generation  
The nodal coordinates of the finite element mesh are internally computed by the 
program based on the reference rectangular grid system shown in Figure 2-2. 
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Figure 2-2. The Reference Grid System 

A group of grid lines, orthogonal to the X and Y-axes, are defined by inputting 
their coordinates. The intersection of two orthogonal grid lines forms a grid 
intersection. The space formed by the intersection of two consecutive X-grid lines 
and two consecutive Y-grid lines is a grid space. The assembling of plate finite 
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elements to the slab system is done by assigning element thicknesses to the grid 
spaces. 

Preparing the Input 
The first step in preparing the input is to draw a scaled plan view of the slab. The 
plan should include the boundaries slab, variations in the slab thickness and 
material properties, openings within the slab, and any variations in the soil sub-
grade modulus. All superimposed loads applied on the slab should also be shown.  

The next step is to superimpose a rectangular grid system over the plan of the slab. 
The following factors control the grid layout:  

1. Grid lines must exist along slab boundaries and openings. Slab boundaries not 
parallel to the X- or Y-axis may be defined by steps that approximate the 
sloped boundary.  

2. Grid lines must exist along the boundaries of slab thickness changes, slab 
material property changes, and soil property changes. 

3. Grid lines must exist along boundaries of surface loads. 

4. Grid lines must intersect at the locations of point loads and point supports.  

The above guidelines basically form the major grid lines, which produce the 
minimum number of finite elements for the particular mat geometry. The mesh can 
be refined by supplementing the model with minor grid lines between the major 
grid lines. Minor grid lines need to be added to achieve a uniform, well-graded 
mesh that produces results that will effectively capture the variations of the 
displacements and element forces. The location of the minor grid lines also 
depends on the level of accuracy that is desired from the analysis.  

While the use of finer meshes will generally produce more accurate results, it will 
also require more solution time, computer memory, and disk space. Elements with 
length or width about 1.5 times the thickness and with aspect ratios (length/width) 
near unity are generally expected to produce accurate results for regions having 
gradual changes of curvature. For slab regions where heavy concentrated forces 
are applied and where drastic changes in geometry exist, the use of finer element 
meshes may be required. Thus, in order to obtain a practical as well as an accurate 
analytical solution, engineering judgment must be used.  

The member nodal incidences are internally computed by the program. All nodes 
and members are numbered from left to right (in the positive X-direction) and 
from bottom to top (in the positive Y-direction), as shown in Figure 2-3. When the 
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reference grid system and/or assembling of elements is modified, the program 
internally modifies all nodes and elements.  

Since the internal sequence of degrees-of-freedom follows the nodal numbering, 
and since pcaMats uses a modified Crout equation solver, the side of the slab with 
less nodes (i.e. less degrees-of-freedom) should be considered in the X-direction in 
order to save solution time, memory and disk space. 
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Figure 2-3. Node and Element Numbering 

The Plate Element 
The rectangular plate finite element used in the program has four nodes at the 
corners and three degrees of freedom (Dz, Rx and Ry) per node, as shown in Figure 
2-4. This element considers the thin plate theory, which makes use of the 
following Kirchhoff hypotheses:  

1. The deflection of the mid-surface is small compared to the thickness of the 
plate.  

2. The mid-plane remains unstrained subsequent to bending.  

3. Plan sections initially normal to the mid-surface remain plane and normal to 
that surface after bending.  

4. The stress component normal to the mid-plane is small compared to other 
stress components and is neglected.  

The element material is homogeneous, elastic, isotropic, and obeys Hooke’s law.  
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Note that when deflections are not small, the bending of plates is accompanied by 
strain in the mid-plane. Further, for thick slabs, shear deformations (which are not 
considered by the program) may be significant, and a finite plate element based on 
the more general Mindlin’s Theory may be required. The element formulation 
considers constant thickness and material properties. Consequently, cracking 
effects or changes in the slab elevation are not taken into account. 
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Figure 2-4. The Plate Finite Element 

Nodal Restraints and Slaved Degrees-of-Freedom  
All nodal degrees-of-freedom (DOF) are assumed to be initially released (i.e., free 
to move). Mathematically speaking, each DOF implies an equilibrium equation; 
however, nodal DOFs may be fully restrained against displacement and/or rotation. 
Furthermore, they may be slaved to share the same displacement or rotation at 
specific nodes.  

Slaving of degrees-of-freedom produces a stiffer slab system and reduces the 
number of equations to be solved. It should be noted that slaved degrees-of-
freedom (SLDOF) are assigned by grouping of nodes. A group of nodes can be 
designated to share the same Dz, Rx or Ry. If a group of nodes should share all three 
degrees-of-freedom, three different SLDOF groups (one for each DOF) must be 
defined. It should also be noted that a node can belong to more than one SLDOF 
group as long as these groups are slaved for different degrees-of-freedom. The 
external load corresponding to a SLDOF group corresponds to the sum of loads 
applied to all slaved nodes in the groups. 
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The Winkler’s foundation 
The soil supporting the slab is modeled as a group of linear uncoupled springs 
(Winkler type) concentrated at the nodes. The soil element is tensionless, 
weightless, and has one degree of freedom, which is the displacement in the Z 
direction (Dz). The contribution of each element node to the soil spring stiffness is 
simply the nodal tributary area (1/4 the element area) times the soil subgrade 
modulus Ks, under the element.  

The contact pressure, Pz, under each element node 
is proportional to the nodal deflection, Dz.  

 zsz DKP = . Eq. 2-1 

Translational
Spring

Z
Y

X

KnsKs

Usually, several factors are considered in the 
determination of the subgrade modulus: the size 
and shape of the footing, soil type below the 
footing and at greater depths, type and duration of 
loading, footing stiffness, and superstructure 
stiffness. The program does not perform any 
correction on the input subgrade modulus to 
account for these or any other factors. 

 Figure 2-4. The Soil Element 

Additional nodal springs may be assembled in parallel to the Winkler’s springs, as 
shown in Figure 2-5. Accordingly, their linear stiffness, Kns, is added to the 
equivalent nodal spring constant.  

The spring reaction at a particular node is proportional to the nodal deflection, Dz.  

 znsz DKF = . Eq. 2-2 

Piles 
Piles are modeled as springs connected to the nodes of the finite element model. 
However, in this case, punching shear check is also performed. It is not for the 
additional springs described in the previous chapter.  

The spring constant Kp for a pile is calculated from the formula  

 
S

QK u
p = , Eq. 2-3  
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where Qu denotes the load applied to the pile and S is the corresponding settlement 
of the pile. Assuming soil allowable pressure Pall acting on the pile base, Qu 
equals pall AP ⋅ , where Ap is pile cross sectional area. Neglecting long-term effects, 
the settlement of pile is estimated from the empirical formula for a single pile in 
cohesionless soil [8]:  

 
pp

u

EA
LQDS +=

100
, Eq. 2-4  

where D is pile diameter, L is pile length, and Ep is modulus of elasticity of pile 
material. For noncircular piles an effective diameter is calculated from the formula  

 
π

pA
D

4
= . Eq. 2-5  

The Nonlinear Solution 
The supporting soil is assumed to be tensionless. When tensile contact pressure 
(nodal uplift) occurs, an iterative procedure is used to eliminate the corresponding 
nodal spring stiffness contribution to the global stiffness of the entire slab/soil 
structural system and to re-solve the equilibrium equations.  

A maximum number of iterations, as well as a maximum displacement limit, are 
the controlling parameters for the solution of the nonlinear problem. This iterative 
procedure is repeated for each load combination. When the limits are exceeded for 
a particular load combination, the program still attempts to solve for the remaining 
load combinations. 

Types of Loads  
External loads are applied as concentrated nodal loads and/or element surface 
loads according to the sign convention shown in Figure 2-6. 

A concentrated nodal load consists of a vertical load, Pz, and two concentrated 
moments about the X and Y axes, Mx and My. It should be noted that a positive 
vertical load is applied upward (in the positive Z-direction). 
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Figure 2-6. The Applied Loads 

The uniform element surface load, wz, applied over an element is internally 
discretized by the program into equivalent nodal loads as shown in Eq. 2-6. 

 ⎧
 
⎪
⎪

 ⎪

 ⎪

 ⎪
  Eq. 2-6  

 ⎪
⎪

 ⎪
⎪

 
⎪
⎪

 ⎪

 ⎩

ba

a
b

a
b

a
b

a
b

w

M
M
P

M
M
P

M
M
P
M
M
P

z

ly

lx

lz

ky

kx

kz

jy

jx

jz

iy

ix

iz

⋅⋅

⎪
⎪
⎪
⎪
⎪
⎪
⎪
⎪

⎭

⎪
⎪
⎪
⎪
⎪
⎪
⎪
⎪

⎬

⎫

⎪
⎪
⎪
⎪
⎪
⎪
⎪
⎪

⎩

⎪
⎪
⎪
⎪
⎪
⎪
⎪
⎪

⎨

⎧

−

−
−

−

⋅=

⎪
⎪
⎪
⎪
⎪
⎪
⎪
⎪

⎭

⎪
⎪
⎪
⎪
⎪
⎪
⎪
⎪

⎬

⎫

⎪

⎪

⎪

⎪

⎨

24/
24/
4/1
24/
24/
4/1
24/
24/
4/1
24/
24/
4/1

where a and b are the element dimensions.  

The self-weight of the slab is computed internally based on the concrete unit 
weight and the thickness of each element. The self-weight is treated like a surface 
load and may optionally be considered in the analysis under the dead load case. 
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Load Cases and Combinations 
All applied loads are categorized into six load cases: A through F. Loads are 
applied to the slab under a load case. The slab is analyzed and designed under load 
combinations. A load combination is the algebraic sum of each of the load cases 
multiplied by a load factor.  

Load combinations are categorized into Service level and Ultimate level. For each 
service level combination, the nodal deflections, element pressures, and nodal 
spring reactions are output. For an ultimate level combination, the element bending 
moments are output. 

The Solution 
The solution process is summarized in the following steps:  

1. Compute the plate element stiffness matrix1 

2. Compute the soil element stiffness matrix.  

3. Assemble the global stiffness matrix.  

4. Combine the applied loads based on the defined load combinations and form 
the load vector.  

5. Compute the displacement vector, U, by solving the equilibrium equation:  

 FUK = , Eq. 2-7 

where K is the structural stiffness matrix and F is the load vector.  

6. If uplift is detected at any node (upward displacement), the soil contribution at 
that node is eliminated and the procedure (from step 2 above) is repeated. This 
is checked only if soil is present.  

7. Compute the spring reactions and soil pressures (service combinations only).  

8. Compute the moments at the element nodes (ultimate combinations only).  

9. Repeat steps 4 through 8 for each combination.  

10. For all service level combinations, envelopes are computed for displacements, 
pressures, and spring reactions.  

                                                           
1 Reference 5. 
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11. For all ultimate level combinations, the element bending moment envelopes 
are computed along with the corresponding required area of reinforcing steel. 

Element Nodal Moments 
The orthogonal moments, Mxx and Myy, and the torsional moment, Mxy, are 
computed at the corner nodes of each element. Figure 2-7 shows the element 
moment sign convention used by the program. Note that Mxx is the moment along 
the X-axis and Myy is the moment along the Y-axis. Both moments are positive 
when they produce tension at the top. 

Mxx

Myy
Mxy

Mxy

Y

dy

X

dx

Z

Mxy dyy
Mxy+

MxxMxx dxx+

MxyMxy dyy+

MyyMyy dyy+

 
 

Figure 2-7. Element Nodal Moments 

The principal moments, Mr1 and Mr2, and the principal angle (see Figure 2-8), are 
computed from the general moment transformation equations:  

 ( )θ+θ+θ= 2sinsincos 22
1 xyyyxxr MMMM , Eq. 2-8  

 ( )θ−θ+θ= 2sincossin 22
1 xyyyxxr MMMM . Eq. 2-9  

Note that since Mr1 and Mr2 are principal moments, the torsional moment 
associated with the r1-r2 axes (Mr12) is zero: 

 ( ) ( ) 02cos2sin
212 =θ+θ
−

= xy
xxyy

r M
MM

M , Eq. 2-10  

and the angle θ is 
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Figure 2-7. Element Principal Moment 

Element Design Moments 
In practice, flexural reinforcement is generally provided in the orthogonal 
directions of the slab system (X-Y) and not in the principal directions (r1-r2). 
Therefore, the Principal of Minimum Resistance2 is used by the program to obtain 
values for the design moments, which include the effects of the torsional moment.  

The equivalent design orthogonal moments Mux and Muy are computed as follows:  

• For top reinforcement where positive moments produce tension:  

 xyxxux MMM += , Eq. 2-12  

 xyyyuy MMM += . Eq. 2-13  

However, if either Mux or Muy is found to be negative, the negative value of 
the moment is changed to zero and the other moment is given as follows:  

 if 0<uxM , then 0=uxM  and 
xx

xy
yyuy M

M
MM

2

+= , Eq. 2-14  

                                                           
2 References 1, 2, 3, and 4. 
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 if 0<uyM , then 0=uyM  and 
yy

xy
xxuy M

M
MM

2

+= . Eq. 2-15  

 

• For bottom reinforcement where negative moments produce tension:  

 xyxxux MMM −= , Eq. 2-16  

 xyyyuy MMM −= . Eq. 2-17  

However, if either Mux or Muy is found to be positive, the positive value of the 
moment is changed to zero and the other moment is given as follows:  

 if 0> , then uxM 0=uxM  and 
xx

xy
yyuy M

M
MM

2

−= , Eq. 2-18  

 if 0>uyM , then 0=uyM  and 
yy

xy
xxuy M

M
MM

2

−= . Eq. 2-19  

In the above equations, Mxx, Myy and Mxy correspond to the maximum principal 
moment obtained from all nodes and all ultimate load combinations. 

Required Reinforcement 
The required area of reinforcing steel is computed based on a rectangular section 
with no compression reinforcement and one layer of tension reinforcement. The 
assumptions and limits used conform to the design specifications based on the 
accepted Strength Design or Limit States theories.  

The maximum usable strain at the extreme concrete compression fiber is assumed 
to be 0.003 (0.0035 for CSA). To compute the stress in the steel layer, the elastic-
perfectly plastic stress-strain distribution is used. A rectangular concrete stress 
block is used, for which the block depth is:  

 ca 1β= , Eq. 2-20 

where c is the distance from the extreme compression fiber to the neutral axis.  

For the ACI Code:  
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 . Eq. 2-21 85.005.005.165.0 '
1 ≤−=β≤ cf

For the CSA Standard:  

 . Eq. 2-22 '
1 025.005.167.0 cf−=β≤

The required area of reinforcing steel is: 

 dbAs ρ= , Eq. 2-23 

 ( )mg −−=ρ 11 , Eq. 2-24 

 
fcc

u

bdf
Mm

φφα
= 2'

1

2 , Eq. 2-25 

 
ys

cc

f
fg

φ
φ

α=
'

1 . Eq. 2-26 

Factor α1 is the ratio of the average stress in the rectangular compression block to 
the specified concrete strength. It equals 0.85 for ACI Code and  
but not less than 0.67 for the CSA Standard. 

'0015.085.0 cf−

Maximum reinforcement 
For the ACI Code, the maximum reinforcement ratio is derived from the 
condition3 that the net tensile strain at nominal strength is not less than 0.004. 

For the CSA Standard, the area of tension reinforcement is such that the neutral 
axis-to-depth ratio is4:  

 
yfd

c
+

<
700

700  Eq. 2-27  

When the required area of steel exceeds the maximum allowed by the code, the 
program outputs the moment capacity, Mmax, based on the maximum allowed steel 
area.  

                                                           
3 ACI 318-02, 10.3.5 
4 CSA A23.3-94, 10.5.2 
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Minimum reinforcement 
The minimum reinforcement is computed as the minimum reinforcement ratio 
defined by the user times the gross area.  

Punching shear check 
The punching shear in pcaMats is checked for columns and piles as per: 

 nu vv φ≤ , Eq. 2-28 

where  

v  = factored shear stress, 

vn =  nominal shear resistance of slab, 

φ  = shear resistance factor equal to 0.75 for ACI Code and 0.60 for CSA 
Standard. 

The nominal shear resistance, vn , is a sum of nominal shear resistance provided by 
shear reinforcement, vs , and nominal shear resistance, vc, provided by concrete. In 
pcaMats vs is assumed to be zero and vc is taken as the smallest of vc1, vc2, and vc3. 
For the ACI Code 

  c
c

c fv '421 λ⎟⎟
⎠

⎞
⎜⎜
⎝

⎛
β

+= , Eq. 2-29 

 c
s

c f
b

dv '2
0

2 λ⎟⎟
⎠

⎞
⎜⎜
⎝

⎛ α
+= , Eq. 2-30 

 cc fv '43 λ= ,  Eq. 2-31 

where: 

cβ  =  the ratio of long side to short side of the column (or the pile), 

sα  = 40 for interior columns, 30 for edge columns, 20 for corner columns, 

b0 =  perimeter of the critical section, 

d  =  average effective depth of the critical section segments, 

'
cf = square root of compressive strength of concrete. 
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For the CSA Standard: 

 c
c

c fv '4.02.01 λ⎟⎟
⎠

⎞
⎜⎜
⎝

⎛
β

+= , Eq. 2-32 

 c
s

c f
b

dv '2.0
0

2 λ⎟⎟
⎠

⎞
⎜⎜
⎝

⎛ α
+= , Eq. 2-33 

 cc fv '4.03 λ= , Eq. 2-34 

with  equal 4 for interior columns, 3 for edge columns, and 2 for corner 
columns. Factor 

sα
λ  is used to account for lightweight concrete and is equal to 1.0 

for normal concrete, 0.85 for sand-lightweight concrete and 0.75 for lightweight 
concrete. These values apply to both ACI Code and CSA Standard. 

The projection of the critical section to the middle surface of the slab is a polygon 
located so its perimeter b0 is a minimum and the distance between its segments ant 
the column is not less than a half of slab effective depth. For circular column and 
piles, the critical section is approximated by a polygon with ten segments per 
quarter. The depth of each segment can be different depending on the depth of the 
slab at the location of the segment. In the case of edge or corner columns and piles, 
segments of the critical section that lie outside of the slab are disregarded.  

For such defined section the area Ac, the coordinates { }cc yx ,  of the centroid, and 
Jxx, Jyy, Jxy properties are calculated. Force (Puz) and moments (Mux and Muy) 
applied at the center of the column (pile) are transformed to the centroid of the 
critical section. The unbalanced moments to be transferred by eccentricity of shear 
are: 

 ))(( cfuzuxvxvx yyPMM −+γ= , Eq. 2-35 

 ))(( cfuzuyvyvy xxPMM −−γ= , Eq. 2-36 

where xf, yf are the coordinates of the column (pile) center. If Bx and By denote the 
dimensions of the critical section then the fractions of the unbalanced moments 
transferred by eccentricity of shear can be calculated as 

 

y

x
vx

B
B

3
21

11
+

−=γ , Eq. 2-37 
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−=γ , Eq. 2-38 

At each vertex of the critical section, the factored shear stress vu is calculated from 
the formula: 

 ( ) x
JJJ

JMJM
y

JJJ
JMJM

A
Pyxv

xyyyxx

xyvxxxvy

xyyyxx

xyvyyyvx

c

uz
u 22,

−

+
−

−

+
+= , Eq. 2-39 

where x, y are the vertex coordinates relative to the centroid of the critical section. 
Vertex that governs the punching shear check is the one that has the maximum 

( cu vv φ/ )  ratio. 

Program Results  
The program output is organized into tables that may be optionally viewed, printed, 
or sent to a file. Furthermore, the tables may be fully or partially output for all or 
for only selected nodes, members and combinations.  

The program distinguishes between individual (service or ultimate) combination 
results and envelope results (which include the maximum values from all load 
combinations). While envelope results are always saved, individual combination 
results are saved only if so selected in the LOAD COMBINATION dialog box.  

Load Vector:  
This table is output for individual ultimate load combinations. It lists the nodal 
load vector that is actually used by the program for each load combination. The 
axial force, Fz, moment about X, Mx, and moment about Y, My, at each node 
includes the factored dead, live and lateral forces at the node, including the 
discretized effects of uniform surface loads. Positive forces are applied in the 
direction of the positive Z-axis (upward) and positive moments are determined 
using the right-hand rule.  

Nodal Displacements and Rotations:  
This table is output for individual service and individual ultimate load 
combinations. It lists the displacement vector for each load combination. The table 
lists the displacement, Dz, and the two rotations about the X and Y-axis, Rx and Ry, 
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respectively. Positive displacement is in the positive Z-direction, and the right-
hand rule is used to determine the direction of the rotations.  

Nodal Spring Displacements and Reactions:  
This table is output for individual service load combinations. For the nodes with 
specified nodal springs, the displacement and reaction are listed. Since the soil is 
assumed tensionless, the pressure is set to zero for positive (upward) 
displacements.  

Element Soil Displacements and Pressures:  
This table is output for individual service load combinations. For the elements with 
specified soil, the displacement and pressure at all four nodes are listed. Since the 
soil is assumed tensionless, the pressure is set to zero for positive (upward) 
displacements. 

Element Nodal Moments:  
This table is output for individual ultimate load combinations. It lists, at each of 
the element four nodes (i, j, k and l), the orthogonal moments (Mxx and Myy), the 
torsional moment (Mxy) and the equivalent principal moments (Mr1 and Mr2), along 
with the principal angle. Note that Mxx and Myy are positive when they produce 
tension at the top and are referred to as moments along the X and Y-axes, 
respectively. For more information about these moments and the sign convention, 
see “Element Nodal Moments” earlier in this chapter.  

Nodal Displacement Envelopes:  
This table lists the maximum vertical displacement, Dz, from all service load 
combinations, along with the governing combination. Again, positive 
displacements are upward in the positive Z-direction.  

Nodal Spring Displacement and Reaction Envelopes:  
For the nodes with specified nodal springs, this table lists the maximum 
displacements and reactions resulting from all service load combinations. The 
governing load combination is listed.  

Element Soil Displacement and Pressure Envelopes:  
For the elements with specified soil, this table lists the maximum displacements 
and pressures resulting from all service load combinations and all four element 
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nodes. The governing load combination and the governing element node are also 
listed.  

Element Top Moment Envelopes:  
For each element, the maximum nodal principal moment (Mr1) producing tension 
at the top resulting from all ultimate load combinations and all for element nodes 
is listed. The governing load combination and the governing element node are also 
listed, along with the corresponding nodal moments (Mxx, Myy and Mxy) and the 
directional angle.  

  

Element Bottom Design Moment and Reinforcement:  
For each element, the maximum nodal principal moment (Mr1) producing tension 
at the bottom resulting from all ultimate load combinations and all four element 
nodes is listed. The governing load combination and the governing element node 
are also listed along with the corresponding nodal moments (Mxx, Myy and Mxy) and 
the directional angle.  

Element Top Design Moment and Reinforcement:  
For each element, the maximum nodal principal moment (Mr1) producing tension 
at the top resulting from all ultimate load combinations and all four element nodes 
is listed. The governing load combination and the governing element node are also 
listed along with the corresponding directional angle and the required area of 
skewed reinforcement. The equivalent design orthogonal moment (Mux and Muy) 
with the required area of reinforcing steel is also listed (see “Element Design 
Moments” earlier in this chapter). If the required area of reinforcing steel exceeds 
the maximum allowed by the code, the ratio of the ultimate moment to the 
maximum moment capacity, (in percent), is reported instead. 
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Chapter 3 
The pcaMats Interface 

The pcaMats interface is made up of the elements as illustrated above. The content 
of the interface’s Main Window changes depending on what you select from any 
menu displayed on the Menu Bar or from any button displayed in the Tool Bar. In 
the illustration above, the Main Window is shown contained within a black frame.  

 

 

 

Title Bar Control Menu Min/Max/Close
Buttons

Menu Bar 

Tool Bar 

MMaaiinn WWiinnddooww  

Status Bar 

 

 



 

The Main Window is made of 4 distinct areas as illustrated here… 
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 Control-Menu:  
The Control-Menu is located in the upper-left corner of the screen. It includes 
commands for restoring, moving, sizing, minimizing, maximizing and closing the 
program.  

Title Bar:  
The Title Bar displays the name of the program (pcaMats 6 in this case), along 
with the path and filename of the current data file in use (D:\MATS 
EXAMPLES\EXAMPLE2.MA6 in this case.) If the file is new and has not yet 
been saved, the word Untitled is displayed in the title bar.  

Min/Max/Close Buttons:  
The Min/Max/Close buttons are located in the upper-right corner of the screen. The 
Minimize button ( ) shrinks the program to the Windows Taskbar. The Maximize 
button ( ) enlarges the program so that it covers the entire desktop. After the 
program has been maximized (takes up the entire screen), the Maximize button ( ) 

3-2  The pcaMats Window 



 

is replaced by the Restore button ( ). Clicking on the Restore button ( ) returns 
the program to its original size. 

Tool Bar:  
The Tool bar is located on the left side of the screen. There are a total of 5 buttons 
on the tool bar each one displays various information in the Main Window of the 
program. The Tool Bar provides access to commands that are also accessible via 
the Menu Bar. The active tool bar’s text will appear in Yellow (highlighted).  

Menu Bar:  
The Menu Bar is located directly beneath the Title Bar. There are a total of 6 
distinct drop-down menus accessible from the Menu Bar. The majority of 
commands appearing in the drop-down menus are also accessible via the 
program’s Main Window area.  

Status Bar:  
The Status Bar is located directly beneath the program’s Main Window area. It 
displays important information such as current units, cursor position, and helpful 
messages.  

Tabs (on Main Window):  
The Tabs are located on the Main Window and vary depending on the button you 
click on the Tool Bar or on the command that you select from one of the drop-
down menus. Each Tab surfaces different GRAPHICS/INPUT AREAS for recording 
and inputting data as it relates to each project.  

Graphics/Input Area (on Main Window):  
The Graphics/Input Area covers most of the Main Window. This is where the 
graphical editing and data input is done.  

Item Listing Area (on Main Window):  
The Item Listing Area appears on the 
right side of the Main Window. The 
items appearing in the listing vary 
depending on the Tab that you select. 
Certain items appearing in listings have “plus” or “minus” signs indicating that the 
list is expandable or retractable, respectively.  

Retracted List Expanded List 
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Information Area (on Main Window):  
The Information Area appears in the lower-right corner of the Main Window. This 
area displays helpful information and values pertinent to the active item that you 
select in the Item Listing Area.  

Using the Menus  
To access a menu item with your mouse, bring the mouse pointer over the menu 
and left-click your mouse to have menu items appear within a drop-down menu. 
Then point to the menu item you wish to access and left-click your mouse again.  

To access a menu item with your keyboard, simultaneously press the ALT key and 
the underlined letter of the menu containing the item you wish to access. Once the 
drop-down menu appears, you can either repeat the above step for the specific 
menu item, or use the up/down arrows on your keyboard, select the specific menu 
item, and press ENTER. For example, to access the Save menu item under the File 
menu, press ALT+F and then either press ALT+S or use the up/down arrows on 
your keyboard to select Save before pressing ENTER.  

Menu Conventions  
The following menu conventions are used in pcaMats. 

Menu Convention Meaning 

Dimmed (grayed out) command. The command is currently unavailable. 

An ellipse (…) following 
a command. 

When the command is selected, a dialog 
box will appear requesting data input or 
listing options to select from.  

A check mark (✔) next to 
a command. 

The command is in effect. When the check 
mark is removed (by selecting the 
command), the command is no longer in 
effect. 
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Using a Dialog Box  
A dialog box is displayed to request information or to supply you with information. 
A dialog box is usually displayed after you click on a button or request the 
program to do something specific such as “open” a data file. For example if you 
choose the Open command from the File menu, the OPEN dialog box will appear 
to float on top of the program as illustrated here…  

Text Box

Com
B

L
Drop down

List 

There are several options within various di
shows only a few.  

Other options include “Radio 
Buttons” and “Check Boxes” as 
illustrated here…  

 To move from option to option 
within a dialog box using only 
your keyboard, press TAB and 
then use the arrow keys on your 
keyboard to select. To move 
backwards, press SHIFT+TAB. 

 

The pcaMats Window 
ist Area
 

mand
uttons

alog boxes. The illustration above 
Check box Radio button 
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Using the Tool Bar  
The Tool Bar located on the left side of the screen provides a fast and easy way to 
access commands or options without having to use the drop-down menus. The 
effect of clicking on any of the five buttons contained in the tool bar will be shown 
in the MAIN WINDOW.  

The PROJECT button provides access to the following four tabs… 

 

 
The ITEM LISTING AREA will provide further access to other commands or options.  

The available commands and options will change depending on the tab that you 
click.  

The remaining buttons and their respective relations are shown below… 
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Working with a List Box  
A List Box displays a list of choices. If there are more choices than can fit in the 
box, scroll bars will automatically appear either on the right or at the bottom of the 
list box allowing you to scroll through the list. To select an item from a list box, 
click the scroll arrows until the item you wish to select appears in the list box and 
then click on that item. If you are using the keyboard, use the arrow keys to scroll 
to the item you want.  

To select a single item from a list box:  
• Using the mouse, click the scroll arrows until the item you want to select 

appears in the list box. Click the item. 

• Using the keyboard, press the UP or DOWN arrow key to scroll to the item you 
want. 

To select multiple sequential items in a list:  
• Using the mouse, click and hold down the left-mouse button on the first item 

you want to select and then drag the cursor to the last item you want to select. 
Alternatively, click on the first item you want to select, press and hold down 
the SHIFT key and click on the last item you want to select. Both items and all 
items in between are selected. To cancel the selections, release the shift key 
and click any item. 

 
• Using the keyboard, press the UP or DOWN ARROW key to move the cursor to 

the first item you want to select. Press and hold down the SHIFT key and 
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continue to press the arrow key repeatedly until all the items you want are 
selected. To cancel the selections, release the SHIFT key and press one of the 
arrow keys.  

 To select multiple non-sequential items in a list:  
• Using the mouse, press and hold down the CTRL key and click each item you 

want to select. To cancel the selection, press and hold down the CTRL key 
and click the item again  

 
• Using the keyboard, press the UP or DOWN ARROW key to move the cursor to 

the first item you want to select. Press and hold down the CTRL key and press 
the SPACEBAR. Continue to press and hold down the CTRL key and use the 
arrow key until you get to the next item you want to select and then press the 
spacebar again. Repeat these steps until all items have been selected. To 
cancel the selections, simply release the CTRL key and press one of the arrow 
keys.  

Working with a Drop-Down List 
A Drop-Down list will appear as a rectangular box with the current 
selection marked and with the following symbol to the right of it…  

To see a listing of available choices, click the symbol (arrow) or 
press DOWN ARROW on your keyboard. Make your selection in the 
appearing list by either clicking on it with the mouse or by 
selecting it with the DOWN ARROW on your keyboard. 
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Working with a Text Box  
Text Boxes are where data or information is typed in. When you move into an 
empty text box, an insertion point (flashing vertical bar) appears. The text you type 
starts at the insertion point. If the box already contains text and you wish to 
overwrite it, simply select the text, delete it, and then type in the new text.  

 

Using a Command Button  
The Command Button (or PUSH BUTTON) is labeled to do exactly 
what it says. The OPEN, OK and CANCEL buttons are common 
command buttons. A command button followed by an ellipsis (…) 
opens another dialog box. The currently selected button has a darker 
border than other buttons displayed on the dialog box. The button 
may either be clicked on with the mouse or you may select it and 
press ENTER on your keyboard.  

Using a Radio Button  
The Radio Button is one of a group of 
related options in which you can select 
only one. When an option is selected, the 
selected option button will display a black 
dot. To select an option with the mouse, simply click the mouse button on the 
respective option. With the keyboard, press TAB to move to the group of options 
that contains the entry you want and then use the arrow keys to select the 
respective option.  

Using a Check Box 
The Check Box is an option that can be turned on or off. 
Unlike Radio Buttons, you can turn on as many check boxes 
as you like within one dialog box, even if they are all within a 
group. When a check box is turned on, and “X” appears in the 
box. If you are using a mouse, click a blank check box to 
select it or click a selected check box to clear it. If you are using a keyboard, press 
TAB to move to the checkbox and then press the SPACEBAR to either select or 
unselect the box.  
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Zooming and Translating while Assigning  
While using any of the Assign menu or ASSIGN tool bar commands, the mouse 
action is reserved to select or deselect nodeas and elements. Note however that you 
may still zoom or translate the graphical image without selecting the 
corresponding commands from either the View menu or the bottom of the MAIN 
WINDOW. 

Using the mouse:  
By pressing and holding down a special key or key combinations, the mouse 
action switches to zoom or translate… 

Key to press Mouse action 

SHIFT  Zoom in (left mouse button)  

SHIFT  Zoom out (right mouse button)  

SHIFT+CTRL  Translate  

CTRL  Rotate (in 3D mode only)  

File Menu  
The File menu gives access to file operations, printing operations and to exiting 
the pcaMats program. 

New  
Clears any input data and returns the data to the 
default values so that a new data file may be input. 

Open  
Opens an existing data file.  

Save  
Saves the changes made to the current data file to 
disk.  

Save As  
Enables you to name or rename a data file.  
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Revert  
Discards any changes to the data file and returns to the most recently saved version 
of the data file. This option will only be available if the data file has been 
previously saved and there have been modifications done on the data file since. Do 
not save the data file immediately prior to reverting otherwise you will revert to 
nothing.  

Print Results  
Provides a printout of the input and output data.  

Print Screen  
Prints the graphical image displayed in the GRAPHICS/INPUT AREA of the MAIN 
WINDOW. 

Exit  
Ends the pcaMats program. 

Define Menu 
The Define menu provides access to commands used to define all of the input data. 
The information you input via the commands found under the Define menu will be 
used when assigning, and for calculating and designing the slab. 

General Info  
Defines and records the particulars on the project including 
project name and description, project date and time, and 
engineering parameters including units of measure and design 
code. 

Grid  
Defines the grid lines that make up the rectangular grid 
system. The slab model is defined based on the grid system 
specified here. This command also gives access to the grid 
preferences where you are able to show/hide node and 
element numbers, select between dotted or solid grid lines, 
and specify the coordinate precision.  
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Library  
Provides access to libraries from which data items can be imported to the current 
project or where data items can be recorded so they can be used in other projects.  

Thickness  
Defines the plate element thickness entries.  

Concrete  
Defines the concrete material properties including compressive strength, unit 
weight, Young’s modulus and Poisson’s ratio.  

Soil  
Defines soil properties including subgrade modulus and allowable pressure. 

Reinforcing Steel  
Defines reinforcing steel material properties including yield strength and Young’s 
modulus.  

Design Parameters  
Defines the parameters that set the criteria for designing the slab. These parameters 
include minimum reinforcement ratio and distance of reinforcement from top and 
from bottom in both directions.  

Columns  
Defines column properties including type and cross section dimensions.  

Nodal Springs  
Defines nodal spring entries including the spring constant (K).  

Slaved Nodes  
Defines slaved nodes and their respective degrees of freedom (Dz, Rx, Ry). 

Piles  
Defines pile properties including pile type, cross section dimensions, pile length, 
material properties, and soil. These properties are used to calculate the equivalent 
spring constant for a pile.  
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Loads  
Defines element and nodal load entries for up to six load cases (A to F).  

Load Combinations  
Defines load combinations for both service and ultimate levels under which the 
model is to be analyzed and designed. 

Assign Menu 
The Assign menu provides access to commands used to input the model geometry 
and assign the defined properties and loads to the nodes and elements. All 
assignments are done graphically. 

Thickness  
Assigns the various valid plate element thicknesses to the 
defined grid. 

Concrete 
Assigns the various concrete properties to the defined 
elements. 

Soil  
Assigns the various soil properties to the defined elements.  

Reinforcing Steel  
Assigns the various reinforcing steel properties to the defined elements.  

Design Parameters  
Assign the various design parameters to the defined elements.  

Columns  
Assign the various columns to the nodes.  

Nodal Springs  
Assigns the various nodal springs to the nodes.  
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Slaved Nodes  
Assigns the various slaved nodes that share the same degree of freedom. 

Restraints 
Assigns restraints for restraining nodal degrees of freedom.  

 Piles  
Assign the various piles to the nodes.  

Surface Loads  
Assigns the various surface loads to the elements.  

Nodal Loads  
Assigns the various nodal loads to the nodes. 

Solve 
The Solve menu provides access to commands used to execute the analysis and 
design. 

Execute  
Executes the solver portion of the program.  

View Results  
Provides access to the results after a successful run.  

View Contours  
Provides access to graphical representations after a successful run. 

View Menu  
The View menu provides access to commands used to manipulate the Graphical 
display and to control what is to be displayed in the GRAPHICS AREA. 

3D  
Toggles the model between isometric view and plan view. 
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Status Bar  
Toggles the Status Bar at the bottom of the screen on or off.  

This Menu (Ctrl+F12) 
Toggles the Menu Bar at the top of the screen on or off.  

Reset 
Resets the graphical window to the default view. Zooming and 
Translating while Assigning 

Zoom-in 
Sets the graphical window in the zoom-in mode. 

Zoom-out 
Sets the graphical window in the zoom-out mode. 

Rotate 
Sets the graphical window in the rotate mode. 

Pan 
Sets the graphical window in the pan mode. 

Options Menu 
The Options menu provides access to commands used to save certain settings as 
defaults for subsequent new projects. 

Startup defaults  
Provides access to saving defaults such as Units of 
measurement and design code so that the system knows to 
use these for any future data file creations.  

Autosave  
Provides access to specify that the system automatically save data periodically 
without you having to necessarily select the File / Save command.  
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Font & Color  
Provides access to specify the font used in displaying node and element numbers 
as well as access to modify the color settings of the Graphical display area.  

Statistics  
Provides access to information such as total number of nodes, elements, and 
definitions. 

Vertical scale 
Allows you to enter a factor for scaling the slab image along the Z-axis. 

Display preferences 
Provides access to turning on and off the display of node and element numbers, 
setting the grid line width, and specifying the precision of coordinates displayed in 
the graphics window. 

Help Menu  
The Help menu provides access to electronic support resources and to information 
on the pcaMats version. 

Help Topics  
Provides access to all available help topics. Click on any topic 
and a help screen will appear with information about that item. 

About pcaMats 
Displays a message box displaying copyright information and the version number 
of pcaMats. 
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Chapter 4 
Operating pcaMats 

In this chapter, the sections follow the order in which commands and options 
appear under the subsequent menu items.  

We begin with those found under the File menu and end with those under the Help 
menu. 

Many of the commands and options that appear under these menus are also 
accessible by other methods. Consequently, these other methods are also explained.  

Creating a New Data File  
When pcaMats is first loaded, the program is ready to begin receiving input for 
a new project. Unless you save the file, the data will not have a filename 
associated with it, and the title bar will display the word Untitled as illustrated 
here…  

 
• From the File menu, choose New. This clears the screen in preparation for a 

new project or data entry file and returns the program to its default settings.  

• If existing data on an open project has been changed prior to executing the 
New command, the program will display the following message box inquiring 
whether you wish to save the data on the open project or data file before 
creating a new file… 

 

 



 

Opening an Existing Data File 
From the File menu, choose Open to have the program display the following 
dialog box…  

 
All files with MA6 extensions contained in the current drive and directory are 
displayed in the listing.  

To open a MA6 file that exists in another drive or directory, use the LOOK IN drop-
down list and locate the folder where the file exists. Once you locate the folder, the 
file will appear in the listing. From the white listing area, either select the file that 
is to be opened and click on the OPEN button, or simply double-click on the 
respective file.  

You can also open data files with MAT extension that were created by the 
previous (5.10/5.20) versions of the program. Use FILES OF TYPE drop-down list to 
change the type of data files displayed in the OPEN dialog box and browse to the 
file you want to open. 

Saving the Data 
pcaMats files are saved in binary format with MAT extensions. When information 
in a data file is modified and until the file is saved, the Title bar will display the 
word (Modified) as illustrated here… 

 

To save your data with the same filename:  
• If you are editing an already existing data file and that file has previously been 

saved (i.e. the TITLE BAR displays a filename), then from the File menu, 
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choose the Save command. The changes will be recorded under the same 
filename and the old data file will be overwritten.  

To save your data for the first time or to give an existing data file a new filename:  
• If you are saving a new data file for the first time (i.e. the TITLE BAR displays 

Untitled), then when you choose Save or Save As from the File menu, the 
following SAVE AS dialog box will appear…  

 
• Similarly, If you are editing an already existing data file and that file has 

previously been saved (i.e. the TITLE BAR displays a filename), and you wish 
to record the changes under a different filename, then choose Save As to have 
the program surface the SAVE AS dialog box.  

• Use the SAVE IN drop-down list and locate the folder where the file is to be 
saved. Once you locate the folder, the white listing area will display any other 
pcaMats files that have been saved in that folder. Double-click in the FILE 
NAME text box and type a filename. (You need not enter an extension since, 
by default, the program will affix the MA6 extension to the filename.) Choose 
the SAVE button to finish recording the data file.  

Reverting to the Last Saved Data File 
• If you have begun to make changes to a data file that has previously been 

saved, (i.e. the TITLE BAR displays a filename), and you suddenly wish to 
discard all the changes and revert back to the previously saved data file, then 
from the File menu, select Revert.  

• The program will verify your intention with the following 
message box… 
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• 
 If you are not sure, another option would be to 

 

led the program will revert to the data previously 
saved by the Autosave function. 

Printing Results 

Click on Yes only if you are certain that you wish to discard all changes since 
the last time the file was saved.
actually save the file under a different name, and then re-open the old data file. 

Note: If Autosave option is enab

• esults to have the program surface the 
REPORTS folder as illustrated here…  
From the File menu, choose Print R

 
Alternatively, you could have clicked on the  button located on the 

•  TITLE PAGE check box if you wish to include a title 

• 

S

toolbar, and then on the REPORTS tab.  
Place a checkmark in the
page with the printout.  

From the INPUT ECHO group, you may select the tables to be printed…  

DEFINITION : Will print all the input data entered using the Define menu 
commands.  
NODES: Will list all nodal data including coordinates, assignments and loads.  
ELEMENTS: Will print all element indexes, assignments and loads.  
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• Select the RESULTS to be printed. (Force Vector and/or displacement Vector) 
For more information about the output tables, see Program Results in 
Chapter 2.  

• In the SERVICE group, select whether to display SPRING DISPLACEMENT & 
REACTIONS and/or ELEMENT DISPLACEMENT & PRESSURE. If check marked, 
the program will display the respective results under the service load 
calculations.  

• In the ULTIMATE group, select whether to display ELEMENT NODAL MOMENTS. 
If check marked, the program will display the respective results under the 
ultimate load calculations.  

• Place a check mark in PUNCHING SHEAR if you wish the output to include the 
respective results of the Punching Shear computations.  

• In the NODES and ELEMENTS groups, select the ALL check box for a 
comprehensive output. For selective printing, specify the range of nodes 
and/or elements to print for.  

• In the COMBINATIONS group, 
select ALL to print for all service 
and ultimate load combinations. 
To print for specific 
combinations, choose the 
SELECT button to have the 
program surface the following 
dialog box…  

• Highlight the combinations from 
the DEFINED COMBINATIONS list, and click on the  but n to move them 
to the SELECTED COMBINATIONS list. Repeat for all load combinations you 
wish to select under both SERVICE and ULTIMATE. To remove a selected 
combination, highlight the combination from the SELECTED COMBINATIONS 
list and click on the 

to

 button. Click on

Choose the ENVELOPES that 

 the OK button when done. 

• are to be 

• can be 

included in the output (printout). 

Alternatively, CHECK ALL button 
used to include all items in the printout. Clicking on the CLEAR ALL button 
will clear all selected items.  
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• In the PRINT TO group, specify whether the output should be sent to the default 
printer or if it should be saved to a file. If FILE is selected, click on the  
button to specify what it should be named and where it should be saved. 

• Click on the PRINT button.  

Printing the screen 
• From the 

Print Scre
File menu, choose 
en to have the 

• 
a

 
 

program surface the standard 
Windows print dialog box 
similar to the following….  

This command will print the 
GRAPHICS AREA in  
WYSIWYG format. In order for 
this command to be enabled, the 
3D View folder must be the 
active folder…  
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Exiting the Program  
From the File menu, choose Exit. If the data file has been modified since the last 
time it was saved, i.e. the word (Modified) appears in the TITLE BAR, then the 
program will display the following message box…  

 
Click on YES to save. NO will exit without saving, and CANCEL will ignore the 
Exit command and return you to the data file. 

Defining the General Info 
• From the File menu, choose Exit. If the data file has been modified since the 

last time it was saved, i.e. the word (Modified) appears in the TITLE BAR), 
then the program will display the following message box…  

 
Click on YES to save. NO will exit without saving, and CANC• EL will ignore the 
Exit command and return you to the data file.  

Operating the Program  4-7 



 

• From the Define menu, choose General Info to have the program surface the 
DESCRIPTION folder as illustrated here…  

Alternatively, you could have clicked on the  button located on the 
toolbar, and then on the DESCRIPTION tab.  

• Enter the Project Name and any details/notes describing the project 
(PROJECT DESCRIPTION). The Project Date And Time will default to 
the instance you started the project however you are free to change it. These 
fields help organize and identify data sets.  

• From the UNITS options group, choose the applicable units of measure and 
from the CODE options group, select the appropriate design code.  

Defining the Grid  
• The rectangular grid system is defined by inputting the coordinates of the X 

and Y grid lines. Note that it is possible to generate multiple, equally spaced 
grid lines as well as individual ones at any location.  

• From the Define menu, choose Grid to have the program surface the GRID 
folder as illustrated here… 
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• Alternatively, you could have clicked on the  button located on the 
toolbar, and then on the GRID tab.  

• If you wish, you can enter a name and description 
for the grid. To do this, double-click on 
DESCRIPTION… found in the right item listing 
area. The program will surface the following 
dialog box…  

• Enter a NAME and DESCRIPTION or note and click 
on OK. 

To Enter Grid Lines Individually:  
• Double-click on SET UP… found in the right 

ITEM LISTING AREA to have the program 
surface the following… 

• Select the grid direction from the respective 
option group, X-Direction or Y-Direction. 
Grids in the X-Direction are perpendicular to 
the X-axis and those in the Y-Direction are 
perpendicular to the Y-axis. 

thogonal 

• 

• 

sh to en ids sepa ally in the other direction 
py the grids you just input 

irection so that they are mirrored in the other direction, choose the 
e, if you just finished defining the grid lines in the X-
utton will copy all X-grid lines to Y-Direction.  

To Delete 
• ish to delete and choose the DELETE button.  

• Enter a grid line coordinate. This value, in 
feet or meters, represents the or
distance from the origin to the grid line. 

Choose the ADD button to add the grid coordinate t

Repeat the two steps above for each grid line.  

o the listing area.  

• If you wi ter gr rately and individu
then repeat the above four steps. If you wish to co
in one d
COPY button. For exampl
Direction then the COPY b

Grid Lines:  
Select the grid line you w
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To Edit the

ODIFY 

To Genera
d

o
and 

• 

right ITEM LISTING AREA to have the 
ace the following… 

place a checkmark in the X-Direction 
s in the Y-Direction, place a checkmark in the Y 

•  direction, enter the coordinate of the first grid line to be generated, 
d lines to be generated (including the first one) and the 

 two consecutive grid lines.  

To Remove d Lines:  

• , any material 
ready been 

• 

To Choose
• Double-click on PREFERENCES… found in the right ITEM LISTING AREA to 

have the program surface the following… 

 Position of a Grid Line:  
• Select the grid line you wish to edit, change its location by overwriting the 

value that is displayed in the COORDINATE text box and choose the M
button.  

te Grid Lines:  
Gri  Lines that are spaced at equal intervals may be generated by inputting the 
co rdinate (distance from the origin) of the first grid line, the number of grid lines 

the spacing between two consecutive grid lines.  

With the GRID tab surfaced, double-
click on GENERATE… found in the 

program surf

• To generate grids in the X-direction, 

checkbox. To generate grid
Direction check box. Recall that grids in the X-Direction are perpendicular to 
the X-axis and those in the Y-Direction are perpendicular to the Y-axis. 

For each
the number of gri
spacing between

• Click on the GENERATE button to have the program generate the respective 
grid lines.  

all the Gri
• Double-click on RESET… found in the r

program surface the following… 

Note that if you choose to proceed

ight ITEM LISTING AREA to have the 

properties, loads, etc. that have al
assigned will have to be re-assigned.  

After confirming your intention, all the grid lines will be removed.  

 the Grid View Preferences:  

4-10  Operating the Program 



 

• If you wish for the grid to display the NODE 
NUMBERS and/or the ELEMENT NUMBERS, place 
checkmarks in the appropriate box(es).  

• Select the style of the grid line, SOLID or DOTTED.  

Specify the • COORDINATE PRECISION. This value 
on of the cursor location. 
cation of the cursor is 

To View th
In th  the symbol next

rid that is 
selected appears in red in the GRAPHICS/INPUT AREA. 

relates to the precisi
(Recall that the lo
displayed in the STATUS BAR.)  

• Click on OK to register your selections/changes.  

e Grid Coordinates:  
e right ITEM LISTING AREA, click on  to the X GRID or Y 

GRID item(s) to expand the list of grid coordinates. Notice how the g

 

Managing Libraries  
The following items may either be recorded during the definition of the project, or 
they may be assigned to the project from existing libraries:  

Selected Grid 
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– Grids – Nodal Springs  

– Element thickness – Slaved Nodes  

– Soil properties – Piles  

– Concrete properties – Concentrated loads  

– Reinforcement properties – Surface loads  

– Design parameters – Load Combinations  

– Columns  

Newly defined items may also be added to existing libraries, or may be saved as 
part of a new library for use on any future projects.  

Items may also be extracted and applied to the current project from numerous 
libraries (i.e. Element thickness 1 and 2 from Library A, and element thickness 3 
and 4 from Library B)  

The file extension of pcaMats library files is: *.MATLIB  

• From the Define menu, choose Library to have the program surface the 
lder as illustrated here…  LIBRARIES fo

 
Alternatively, you could have clicked on the  button located on the 
toolbar, and then on the PROPERTIES tab.  
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To Assign Items from a Library to the Current Project:  
• Click on the  button to 

have the following Windows OPEN 
dialog box appear… 

• Locate the library file and click on 
OPEN to return focus to pcaMats. 
Notice how the contents of the 
selected library appear in the listing 
under “Current Library”… 

•  Click on the  symbol next to 
various items to expand their 
contents. The items that will 
subsequently appear are items that 
have been pre-defined. 

• Select the item and click on the 
 arrow to copy the item and to 

paste it into the current project. 
Any items copied over now 

• 

To Cr e 
• 

become available for assigning. 

 Repeat the above steps to select 
items from additional libraries.  

eat and Save a Library:  
Click on the 

 4-13 

 symbol next to the i
listing to expand their con

t
tents.  

he current project and click on the 

ems appearing under the Current Project 

 • Locate the specific items defined in t
arrow to copy the item and to paste it i

If there are items in the library th
highlight (click on) them and

nto the current library.  

• at you would like to remove, simply 
 click on the  icon 

• To overwrite the library, click on the  button. Any items copied 
me part of the saved library.  

• he

over from the current project now beco

To save the library as new, click on t   button. Any items copied 
oject now become part of the new library. over from the current pr
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Defin  ing material Properties 
Mat ies such as:  

ble pressure (Qa), 

um

 

ss, Concre
folder as 

erial propert

• element thickness, 

• soil modulus (Ks) and allowa

• concrete compressive strength ( '
cf ), unit weight (w), Young’s modulus (Ec), 

and Poisson’s ratio (v), 

• reinforcement yield strength (fy), Young’s modulus (Es), minim  
reinforcement ratio and re-bar location, 

• column type (round or rectangular) and dimensions, must be defined before 
they can be assigned to the elements on the grid.  

• From the Define menu, choose Thickne te, Soil, Reinforcing Steel 
or Design Parameters to have the program surface the PROPERTIES 
illustrated here… 

 
Alternatively, you could have clicked on the  button located on the 
toolbar, and then on the PROPERTIES tab. 
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To define the Element Thickness 
• From the Define menu select Thickness, or if the PROPERTIES folder is 

displayed, click on THICKNESS… found in the right ITEM LISTING AREA to 
have the program surface the Thickness input screen…  

 
• Enter a thickness label or ID in the LABEL text box and enter the 

corresponding thickness in the THICKNESS text box.  

• Click on the ADD button to add the entry to the list box.  

• Repeat the two steps above for each thickness entry.  

• modify 
gister the changes.  

try, select it from the list box and click on the DELETE 

To Define 
• From the Define menu select Soil, or if the PROPERTIES folder is displayed, 

click on Soil… found in the right ITEM LISTING AREA to have the program 
surface the Soil input screen…  

To edit an entry, select it from the list box, its value(s) in the text 
box(es) and click on the MODIFY button to re

• To delete a thickness en
button.  

the Soil Properties:  

 
• Enter a label or Soil ID in the LABEL text box and enter the corresponding 

PRESSURE (Qa) in the SUBGRADE MODULUS (Ks) and soil’s ALLOWABLE 
corresponding text boxes.  
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• Click on the ADD button to add the entry to the list box.  

Repeat the two steps above for each soil entry.  • 

nd click on the MODIFY button to register the changes.  

y, select it from the list box and click on the DELETE 

To Define 
• From the Define menu select Concrete, or if the PROPERTIES folder is 

displayed, click on CONCRETE… found in the right ITEM LISTING AREA to 
have the program surface the Concrete input screen… 

• To edit an entry, select it from the list box, modify its value(s) in the text 
box(es) a

• To delete a soil entr
button. 

the Concrete Properties:  

 
• Enter a label or Concrete ID in the LABEL text box and enter the 

 UNIT WEIGHT (w) in the 

• atically and 

 the value of Ec can be modified if it differs from the calculated value.  

 for the concrete and click on the ADD button to 
 

• its value(s) in the text 
box(es) and click on the MODIFY button to register the changes.  

• To delete a concrete material entry, select it from the list box and click on the 
DELETE button.  

corresponding Compressive Strength ( '
cf ) and

respective text boxes.  

The YOUNG’S MODULUS of elasticity (E ) is calculated automc
will display a result that is respective of the equations in the selected Code. 
Note that

• Enter the POISSON’S RATIO
add the entry to the list box. 

• Repeat the three steps above for each concrete entry.  

To edit an entry, select it from the list box, modify 
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To Define the Reinforcing Steel Properties:  
• From the Define menu select Reinforcing Steel, or if the PROPERTIES folder is 

displayed, click on REINFORCEMENT… found in the right ITEM LISTING AREA 
to have the program surface the Reinforcement input screen…  

 
• Enter a label or Reinforcement ID in the LABEL text box and enter the 

corresponding Yield Strength (fy) and the YOUNG’S MODULUS of elasticity (Es) 
for the steel.  

• Click on the ADD button to add the entry to the list box.  

Repeat the two steps above fo• r each reinforcement entry.  

 its value(s) in the text 

• ox and click 

To Define the Design Parameters:  
n Parameters, or if the PROPERTIES folder 

• corresponding 
MINIMUM REINFORCEMENT RATIO as a percentage of the gross area.  

• Specify the bar cover for the TOP and BOTTOM bars running in the X and Y 
directions. For top bars, the cover is measured from the slab top to the 
centroid of the bar. For bottom bars, the cover is measured from the slab 
bottom to the centroid of the bar.  

• To edit an entry, select it from the list box, modify
box(es) and click on the MODIFY button to register the changes.  

To delete a reinforcement material entry, select it from the list b
on the DELETE button. 

• From the Define menu select Desig
is displayed, click on DESIGN PARAMETERS… found in the right ITEM LISTING 
AREA to have the program surface the Design Parameters input screen.  

Enter a label or ID in the LABEL text box and enter the 
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• Click on the ADD button to add the entry to the list box.  

Repeat the three steps a• bove for each design entry.  

t from the list box, modify its value(s) in the text 
button to register the changes.  

• 

To Define 
• found in 

• To edit an entry, select i
box(es) and click on the MODIFY 

To delete a design parameter entry, select it from the list box and click on the 
DELETE button.  

the Column Dimensions:  
Surface the PROPERTIES folder and click on COLUMN DIMENSIONS… 
the right ITEM LISTING AREA to have the program surface the Column 
Dimensions input screen… 

 
• Enter a label or Column ID in the LABEL text box and select the TYPE of 

COLUMN (Round or Rectangle) from the drop-down list.  

• Enter the dimensions in the respective text box(es). If you select " ound" 
e X-DIM.  

t box.  

• To edit an entry, select it from the list box, modify its value(s) in the text 
box(es) and click on the MODIFY button to register the changes.  

R 
from the TYPE drop-down list, then enter the column’s diameter as th

• Click on the ADD button to add the column to the lis

• Repeat the three steps above for each column entry.  
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• To delete a column entry, select it from the list box and click on the DELETE 
button.  

Defining the Restraints 
Fro  the Define menu, choose Nodal Springs or Slaved Nodes to have the 

ram surface the RESTRAINTS folder as illustrated here…  
m

prog

 
Al rnatively, you could have clicked on the te  button located on the 

bar, and thtool en on the RESTRAINTS tab. 

s:  

  

• Enter a label or Nodal Spring ID in the LABEL text box and enter the 
corresponding Spring Constant.  

• Click on the ADD button to add the entry to the list box.  

• Repeat the two steps above for each Nodal Spring entry.  

To Define the Nodal Spring
• From the Define menu select Nodal Springs, or if the RESTRAINTS folder is 

displayed, click on NODAL SPRINGS… found in the right ITEM LISTING AREA 
to have the program surface the Nodal Springs input screen.
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• To edit an entry, select it from the list box, modify its value(s) in the text 
box(es) and click on the MODIFY button to register the changes.  

• To delete a Nodal Spring entry, select it from the list box and click on the 
DELETE button.  

To Define the Slaved Nodes:  
Slaved nodes are nodes that share a particular degree of freedom (Dz, Rx or Ry). 
A slaved node group must first be defined and then the nodes to be included in the 
group are assigned using the Assign / Slaved Nodes command. A group is defined 
by giving it a label and a degree of freedom.  

• From the Define menu select Slaved Nodes, or if the RESTRAINTS folder is 
displayed, click on SLAVED NODES… found in the right ITEM LISTING AREA 
to have the program surface the Slaved Nodes input screen…  

 
• Enter a label or Slaved Node ID in the LABEL text box.  

From the Degree of Freedom option group, select the degree of freedom that 
the slaved nodes will share, displacement in the Z-direction

• 
 (Dz), rotation 

• e entry to the list box.  

 

value(s) in the text 

•  click on the 

To Define the Piles:  
• Surface the RESTRAINTS folder and click on PILES… found in the right ITEM 

LISTING AREA to have the program surface the Piles input screen.  

about the x-axis (Rx), or rotation about the Y-axis (Ry).  

Click on the ADD button to add th

• Repeat the three steps above for each slaved node group. 

• To edit an entry, select it from the list box, modify its 
box(es) and click on the MODIFY button to register the changes.  

To delete a slaved node group, select it from the list box and
DELETE button.  
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• Enter a label or Pile ID in the LABEL text box and enter the corresponding 

between ROUND, SQUARE, 
RECTANGULAR and H-TYPE.  

• What you select in the PILE 
TYPE drop-down list dictates the fields that will be made available for the PILE 
DIMENSIONS. Use the image that will be displayed just underneath the PILE 
TYPE selection as a guide when filling out the Pile Dimensions.  

• Select the Pile Material by choosing CONCRETE, STEEL, or PRECAST f m the 

rn focus to the Piles 
e list box.  

• s LABEL or 

S, SOIL TYPE, or PILE MATERIAL, click on the EDIT button to 
 corresponding dialog box, modify the value(s) in the text box(es) 
click on the OK button to close the dialog box and to return focus 

• he D

Spring Constant.  

• Click on the ADD button to 
have the program surface 
the following dialog box…  

• Enter a Label for the pile 
and from the PILE TYPE 
drop-down list, select 

ro
respective drop-down list.  

• Use the SELECT SOIL drop-down list to select the soil. Recall that the soil and 
its corresponding properties are defined by you. (See To Define the Soil 
Properties, explained earlier.)  

• Click on the OK button to close the dialog box and to retu
folder. Notice how the pile has been added as an entry to th

• Repeat the seven steps above for each Pile entry.  

To edit an entry, select it from the list box, if you wish to modify it’
SPRING CONSTANT, simply edit the values in the respective text boxes and 
click on the MODIFY button to register the changes. If you wish to edit the 
TYPE, DIMENSION
surface the
and then g 
to the Piles folder.  

To delete a Pile entry, select it from the list box and click on t ELETE 
button. 
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Defin  ing the Loads 
No  and element loads are defined using the Define / Lo  command. They are 
the  assigned to the nodes using the Assign / Nodal Loads command, and to 

ents using the Assign / Surface Loads command.  

dal ads
n

elem

Alte ve clic

• From the Define menu, choose Loads to have the program surface the LOADS 
folder. 

rnatively, you could ha ked on the  button located on the 
tool r, and then on the LOADS tab.  

the Concentrated Load(s):  

ba

To Define 
• Surface the LOADS folder and click on CONCENTRATED… found in the right 

ITEM LISTING AREA to have the program surface the Concentrated Loads input 
screen… 

 
Enter a label or Concentrated Load ID in the LABEL text box.  

From the Case drop-down list, select a load case (A through F). Note that 
loads defined under a

• 

• 
 particular load case may be applied to the slab under 

•  axial force (Pz), a moment about the X-axis (Mx), and a moment 
My). Note that downward forces (Pz) have a negative value. 

e the direction of the moments Mx and My, use the right hand rule.  

• an entry, select it from the list box, modify its value(s) in the text 
box(es) and click on the MODIFY button to register the changes.  

that load case only.  

Enter an
about the Y-axis (
To determin

• Click on the ADD button to add the concentrated load to the list box. Note that 
the data in the list box are sorted by type and case. Only loads of the same 
type and case are listed together.  

• Repeat the four steps above for each concentrated load.  

To edit 
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• To delete a load entry, select it from the li nd click on the DELETE 
button.  

st box a

To Define the Surface Load(s):  
• Surface the LOADS folder and click on SURFACE… found in the right ITEM 

LISTING AREA to have the program surface the Surface Loads input screen… 

 
• Enter a label or Surface Load ID in the LABEL text box.  

 F). Note that 

• ity W  as a force per unit area. Note that downward forces 

• 

• 

s value(s) in the text 
anges.  

ELETE 

Defining th ombinations 
nd elements under six load cases (A through F). The 

der load combinations and the analysis is performed for 

•  
surface the LOAD COMBINATIONS folder as illustrated here…  

• From the Case drop-down list, select a load case (A through
loads defined under a particular load case may be applied to the slab under 
that load case only.  

Enter the load intens z
(Wz) have a negative value.  

Click on the ADD button to add the surface load to the list box. Note that the 
data in the list box are sorted by type and case. Only loads of the same type 
and case are listed together.  

Repeat the four steps above for each surface load entry.  

• To edit an entry, select it from the list box, modify it
box(es) and click on the MODIFY button to register the ch

• To delete a load entry, select it from the list box and click on the D
button. 

e Load C
Loads are applied to nodes a
load cases are combined un
each load combination.  

From the Define menu, choose Load Combinations to have the program
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• Alternatively, you could have clicked on the  button located on the 

toolbar, and then on the LOAD COMBINATIONS tab.  

Enter a label or Load•  Combination ID in the LABEL text box, and select a 

nts and required reinforcement are output for 

• ad case (A through F) and click the ADD button 

ns are saved to disk only if this option is checked. Envelope results 
 regardless of the status of this option. Check or clear 

• e(s) in the text 
box(es) and click on the MODIFY button to register the changes.  

• To delete a load combination, select it from the list box and click on the 
DELETE button. 

combination LEVEL, (Service or Ultimate). Deflections are output for all 
combinations. Pressures and spring reactions are output for Service level 
combinations. Design mome
Ultimate level load combinations. Envelope results are computed for all 
service combinations as well as for all ultimate combinations.  

Enter load factors for each lo
to add the load combination to the list box.  

• Once all the load combinations have been 
defined, click on the OPTIONS button to have the 
program surface the following dialog box…  

• Check or clear the SAVE COMBINATION RESULTS option. Results for individual 
combinatio
are always saved to disk
the I S -WNCLUDE ELF EIGHT IN CASE A option. If this option is checked, the 
self-weight of the slab will be automatically computed and included under 
load case A.  

• Repeat the four steps above for each load combination entry.  

To edit an entry, select it from the list box, modify its valu
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Assigning the material properties 
Once the grid, all components, material properties, design parameters, loads and 
load combinations have been defined, you are ready to start assigning them - 
thereby putting the project together.  

• From the Assign menu, choose Thickness, Concrete, Soil, Reinforcing Steel 
or Design Parameters to have the program surface the PROPERTIES folder as 
illustrated here… 

 
Alternatively, you could have clicked on the  button located on the 
toolbar, and then on the PROPERTIES tab.  

To As
• IES folder is  

sign the Element Thickness: 
From the Assign menu, choose Thickness, or if the PROPERT
displayed, click on the  symbol next to THICKNESS… found in the right 
ITEM LISTING AREA to expand the THICKNESS list. The thicknesses that will 
appear are those defined using the Define / Thickness command. See To 
Define The Element Thickness.  
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• Select the thickness to be assigned. This becomes the active assignment. By 
default, the program will display all elements that share the active assignment 

e Options / Font & Color command. See To 

• 
f grid spaces (or click a single grid space). The selected grid 

spaces are shown in red or in the color specified for ACTIVE OBJECTS in the 
FONT & COLOR folder. See To Change The Font and Color Preference.  

• To delete an element, remove its thickness assignment. To do so, repeat the 
step above using instead, the right mouse button.  

• Repeat the three steps above for each thickness entry.  

To Assign the Soil Properties:  
• From the Assign menu select Soil, or if the PROPERTIES folder is displayed, 

click on the 

in red and the inactive assignment in cyan. Unassigned grid space is by 
default displayed in white. Recall however that you may change the color 
preferences to your liking with th
Change The Font and Color Preferences.  

In the GRAPHICS AREA, using the left-mouse button, marquee select a grid 
space or a group o

 symbol next to SOIL… found in the right ITEM LISTING AREA 
to expand the SOIL list. The soils that will appear are those defined using the 
Define / Soil command. See To Define The Soil Properties.  

• Select the soil to be assigned. This becomes the active assignment. By default, 
the program will display all elements that share the active assignment in red 
and the inactive assignment in cyan. Unassigned elements are by default 
displayed in powder blue. Recall however that you may change the color 
preferences to your liking with the Options / Font & Color command. See To 
Change The Font and Color Preferences.  

• se butto

specified for ACTIVE OBJECTS in the 
e To Change The Font and Color Preference. 

• 

In the GRAPHICS AREA, using the left-mou n, marquee select an 
element or a group of elements (or click a single element). The selected 
elements are shown in red or in the color 
FONT & COLOR folder. Se

• To remove a soil assignment, repeat the step above using instead, the right 
mouse button.  

Repeat the three steps above for each soil entry.  
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To As
• 

sign the Concrete Properties:  
From the Assign menu select Concrete, or if the PROPERTIES folder is 
displayed, click on the  symbol next to CONCRETE… found in the right 
ITEM LISTING AREA to expand the CONCRETE list. The concrete that will 
appear are those defined using the Define / Concrete command. See To 
Define The Concrete Properties.  

• Select the concrete to be assigned. This becomes the active assignment. By 
default, the program will display all elements that share the active assignment 
in red and the inactive assignment in cyan. Unassigned elements are by 
default displayed in powder blue. Recall however that you may change the 

n, marquee select an 
ment). The selected 

n red or in the color specified for ACTIVE OBJECTS in the 
t and Color Preference

•  

• 

To Assign 
• 

color preferences to your liking with the Options / Font & Color command. 
See To Change The Font and Color Preference.  

• In the GRAPHICS AREA, using the left-mouse butto
element or a group of elements (or click a single ele
elements are shown i
FONT & COLOR folder. See To Change The Fon .  

To remove a concrete assignment, repeat the step above using instead, the 
right mouse button.  

Repeat the three steps above for each concrete entry.  

the Reinforcing Steel Properties:  
From the Assign menu select Reinforcing Steel, or if the PROPERTIES folder 
is displayed, click on the  symbol next to REINFORCING STEEL… found in 
the right ITEM LISTING AREA to expand the REINFORCING STEEL list. The 
reinforcing steel entries that will appear are those defined using the 

• 
active 

ces to your liking with the Options / Font & Color 
eferences.  

• In the GRAPHICS AREA, using the left-mouse button, marquee select an 
element or a group of elements (or click a single element). The selected 

Define/Reinforcing Steel command. See To Define The Reinforcing Steel 
Properties.  

Select the reinforcing steel to be assigned. This becomes the active assignment. 
By default, the program will display all elements that share the 
assignment in red and the inactive assignment in cyan. Unassigned elements 
are by default displayed in powder blue. Recall however that you may change 
the color preferen
command. See To Change The Font and Color Pr
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elements are shown in red or in the color specified for ACTIVE OBJECTS in the 

• 

• ch reinforcing steel entry.  

To As n
• 

FONT & COLOR folder. See To Change The Font and Color Preference. 

To remove a reinforcing steel assignment, repeat the step above using instead, 
the right mouse button.  

Repeat the three steps above for ea

sig  Design Parameters:  
From the Assign menu select Design Parameters, or if the PROPERTIES folder 
is displayed, click on the  symbol next to DESIGN PARAMETERS… 
found in the right ITEM LISTING AREA to expand the DESIGN PARAMETERS list. 
The design parameters that will appear are those defined using the Define / 
Design Parameters command. See To Define The Design Parameters.  

you 

To Change The Font and Color Preferences.  

on, marquee select an 
element or a group of elements (or click a single element). The selected 

 color specified for ACTIVE OBJECTS in the 

• t

• 

To Assi n the 

• Select the design parameter entry to be assigned. This becomes the active 
assignment. By default, the program will display all elements that share the 
active assignment in red and the inactive assignment in cyan. Unassigned 
elements are by default displayed in powder blue. Recall however that 
may change the color preferences to your liking with the Options / Font & 
Color command. See 

• In the GRAPHICS AREA, using the left-mouse butt

elements are shown in red or in the
FONT & COLOR folder. See To Change The Font and Color Preference.  

To remove a design parame er assignment, repeat the step above using instead, 
the right mouse button.  

Repeat the three steps above for each design parameter entry.  

g Columns:  
• From the Assign menu select Column Dimensions, or if the PROPERTIES 

folder is displayed, click on the  symbol next to COLUMN DIMENSIONS… 
found in the right ITEM LISTING AREA to expand the COLUMN DIMENSIONS list. 

Select the column entry to be assigned. This becomes the active assignment. 
By default, the program will display all nodes that share the a

 

• 
ctive assignment 

in red and nodes with a different assignment in cyan. Recall however that you 
may change the color preferences to your liking with the Options / Font & 
Color command. See To Change The Font and Color Preferences.  
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• 
in red 

nstead, the right 

 above for each column entry.  

Assigning

In the GRAPHICS AREA, using the left-mouse button, marquee select a node or 
a group of nodes (or click a single node). The selected nodes are shown 
or in the color specified for ACTIVE OBJECTS in the FONT & COLOR folder. 
See To Change The Font and Color Preference.  

• To remove a column assignment, repeat the step above using i
mouse button.  

• Repeat the three steps

 the Restraints  
Onc
load
thereb

e the grid, all components, material properties, design parameters, loads and 
 combinations have been defined, you are ready to start assigning them - 

y putting the project together. 

 
From the Assign menu, choose Nodal Springs, Slaved Nodes or Restraints • 
to have the program surface the RESTRAINTS folder as illustrated above…  

Alternatively, you could have clicked on the  button located on the 
toolbar, and then on the RESTRAINTS tab.  
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To As n
Fixe

• e RESTRAINTS is displayed, 

sig  Nodal Restraints:  
d nodes or supports are assigned using the Assign / Restraints command.  

From the Assign menu select Restraints, or if th
click on the  symbol next to R … foESTRAINTS TEM 
LISTING AREA to expand the RESTRAINTS list. You will be able to restrain D

und in the right I

s of freedom.  

es the active assignment. 
ram will display all nodes that share the active assignment 
th a different assignment in cyan. Recall however that you 

e left-mouse button, marquee select a node or 
a group of nodes (or click a single node). The selected nodes are shown in red 
or in the color specified for ACTIVE OBJECTS in the FONT & COLOR folder. 
See To Change The Font and Color Preference.  

• To remove a nodal restraint assignment, repeat the step above using instead, 
the right mouse button.  

• Repeat the three steps above for each degree of freedom.  

To Assign Nodal Springs:  
• From the Assign menu select Nodal Springs, or if the RESTRAINTS folder is 

displayed, click on the 

z, 
Rx and Ry degree

• Select the nodal restraint to be assigned. This becom
By default, the prog
in red and nodes wi
may change the color preferences to your liking with the Options / Font & 
Color command. See To Change The Font and Color Preferences.  

• In the GRAPHICS AREA, using th

 symbol next to NODAL SPRINGS… found in the right 
ITEM LISTING AREA to expand the NODAL SPRINGS list. The nodal springs that 
appear are those defined using the Define/Nodal Springs command. See To 
Define The Nodal Springs.  

• Select the nodal spring to be assigned. This becomes the active assignment. 
By default, the program will display all nodes that share the active assignment 
in red and nodes with a different assignment in cyan. Recall however that you 
may change the color preferences to your liking with the Options / Font & 

•  or 
elected 

CTS in the FONT & COLOR folder. 
See To Change The Font and Color Preference.  

Color command. See To Change The Font and Color Preferences.  

In the GRAPHICS AREA, using the left-mouse button, marquee select a node
a group of nodes (or click a single node). The s nodes are shown in red 
or in the color specified for ACTIVE OBJE
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• To remove a nodal spring assignment, repeat the step above using instead, the 

To Assign 
•  Nodes, or if the RESTRAINTS folder is 

right mouse button.  

• Repeat the three steps above for each nodal spring entry.  

Slaved Nodes:  
From the Assign menu select Slaved
displayed, click on the  symbol next to SLAVED NODES… found in the right 
ITEM LISTING AREA to expand the SLAVED NODES list. The slaved node 
entries that appear are those defined using the Define / Slaved Nodes 
command. See To Define the Slaved Nodes.  

Select the slaved node to be assigned. This becomes the active assign• ment. By 

 for ACTIVE OBJECTS in the FONT & COLOR folder. 

ed node assignment, repeat the step above using instead, the 

•

To Assign 
• t Piles, or if the RESTRAINTS folder is displayed, 

default, the program will display all nodes that share the active assignment in 
red and nodes with a different assignment in cyan. Recall however that you 
may change the color preferences to your liking with the Options / Font & 
Color command. See To Change The Font and Color Preferences.  

• In the GRAPHICS area, using the left-mouse button, marquee select a node or a 
group of nodes (or click a single node). The selected nodes are shown in red 
or in the color specified
See To Change The Font and Color Preference.  

• To remove a slav
right mouse button.  

 Repeat the three steps above for each slaved node entry.  

Piles:  
From the Assign menu selec
click on the  symbol next to PILES… found in the right ITEM LISTING AREA 
to expand the PILES list. The piles that appear are those previously defined by 
you. See To Define the Piles.  

Select the pile to be assigned. This becomes the active assignment. By default, 
the program will display all nodes that share the active assignment i

• 
n red and 

• n, marquee select a node or 
a group of nodes (or click a single node). The selected nodes are shown in red 

nodes with a different assignment in cyan. Recall however that you may 
change the color preferences to your liking with the Options / Font & Color 
command. See To Change The Font and Color Preferences.  

In the GRAPHICS AREA, using the left-mouse butto
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or in the color specified for ACTIVE OBJECTS in the FONT & COLOR folder. 
See To Change The Font and Color Preference.  

g instead, the right 
mouse button.  

 steps above for each pile in the ITEM LISTING AREA.  

Applying

• To remove a pile assignment, repeat the step above usin

• Repeat the three

 the loads 
Onc
load ready to start assigning them - 

r

• 

e the grid, all components, material properties, design parameters, loads and 
 combinations have been defined, you are 

the eby putting the project together.  

From the Assign menu, choose Surface Loads or Nodal Loads to have the 
program surface the LOADS folder as illustrated here…  

 
Alternatively, you could have clicked on the  button located on the 
toolbar, and then on the LOADS tab.  
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To Apply S
The ommand may be applied to 

 
de

older is 

urface Loads:  
 surface loads defined using the Define / Loads c

the mat elements using the Assign / Surface Loads command. The loads defined 
un r the Dead, Live and Lateral cases are applied under these cases as well.  

• From the Assign menu select Surface Loads, or if the LOADS f
displayed, click on the  symbol next to the load CASE… (A through F) 

ight ITEM LISTING AREA to expand the list. The two load types 
 CONCENTRATED and SURFACE. Expand the Surface load types by 

found in the r
will appear,
clicking on the  symbol next to SURFACE…  

• Select the load to be assigned. This becomes the active assignment. By default, 
the program will display all elements that share the active assignment in red 

 & Color command. 
See To Change The Font and Color Preferences.  

• In the GRAPHICS AREA, using the left-mouse button, marquee select an 
element or a group of elements (or click a single element). The selected 
elements are shown in red or in the color specified for ACTIVE OBJECTS in the 
FONT & COLOR folder. See To Change The Font and Color Preference.  

• To remove a surface load assignment, repeat the step above using instead, the 
right mouse button.  

• Repeat the three steps above for each load case.  

To Apply Concentrated (Nodal) Loads:  
• The concentrated loads defined using the Define / Loads command may be 

applied to the mat elements using the Assign / Concentrated Loads 
command. The loads defined under the Dead, Live and Lateral cases are 
applied under these cases as well.  

• From the Assign menu select Nodal Loads, or if the LOADS folder is 
displayed, click on the 

and elements with a different assignment in cyan. Unassigned elements are by 
default displayed in powder blue. Recall however that you may change the 
color preferences to your liking with the Options / Font

 symbol next to the load CASE… (A through F) 
nd the li

pand th
types by clicking on the   symbol next to CONCENTRATED…  

• Select the load to be assigned. This becomes the active assignment. By default, 
the program will display all nodes that share the active assignment in red and 

found in the right ITEM LISTING AREA to expa st. The two load types 
will appear, CONCENTRATED and SURFACE. Ex e Concentrated load 
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nodes with a different assignment in cyan. Recall however that you may 

es or 

• 
o

Solving th

change the color preferences to your liking with the Options / Font & Color 
command. See To Change The Font and Color Preferences.  

• In the GRAPHICS AREA, using the left-mouse button, marquee select a nod
a group of nodes (or click on a single node). The selected nodes are shown in 
red or in the color specified for ACTIVE OBJECTS in the FONT & COLOR 
folder. See To Change The Font and Color Preference.  

To remove a nodal load assignment, repeat the step above using instead, the 
right mouse butt n.  

• Repeat the three steps above for each load case.  

e model 
Afte
Solv

fold

r inputting the model, the solver portion of the program is executed using the 
e / Execute command.  

From the Solve menu, choose Execute to have the program surface the SOLVER 
er as illustrated here…  

 
rnatively, you could have clicked on the Alte  button located on the 
bar, and then on the RUN SOLVER tab.  tool

• MAXIMUM NUMBER OF ITERATIONS:  
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If uplift is detected during the solution, the soil contribution at the uplift nodes 
is eliminated and the problem is resolved. This procedure is repeated until no 
further uplift is encountered or until the set maximum number of iterations is 

ination will not be 

• REA: 

ibutary area Au, of all soil-
supported nodes in uplift is computed. The program also computes the sum of 

y areas, At, of all non-restrained nodes. The contact area is defined 
 (At - Au)/At. If during the solution, this ratio falls below the 

R POSITIVE NODAL DISPLACEMENT EXCEEDING: 

• COMPUTE REQUIRED REINFORCEMENT BASED ON: 

For each element, each of the design moments (Mux and Muy, top and bottom) 
is computed for a governing ultimate load combination. The governing load 
combination is the one that produces the maximum principal moment (Mr1 or 
Mr2). Each element has four values of Mux and Muy (one at each node). The 
required area of reinforcement for an element may be computed based on:  
• MAXIMUM MOMENT WITHIN AN ELEMENT (the maximum moment at any 

of the four element nodes.)  

• AVERAGE MOMENT WITHIN AN ELEMENT (the average moment value at 
all element nodes.)  

• The input is first verified for any inconsistencies 
or errors. If there is data missing or still required, 
a message box will be displayed.  

solve 
progress 

reached, whichever comes first.  
• MAXIMUM ALLOWED DISPLACEMENT:  

For any load combination, the deflection at each node is checked versus this 
value. If it is exceeded, the solution for that comb
completed.  
MINIMUM CONTACT A

If uplift is detected during the solution, the tr

the tributar
as the ratio
specified minimum, the program stops solving for that particular combination.  

• MAT UPLIFT OCCURS FO

This is the value for displacement beyond which a node is considered to be in 
uplift. 

• The program then switches control to the 
module. A message box reporting the 
and status of the solution is displayed.  
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• 

Messages window.  

iewed using the Solve / View Results 

Viewi  t

When the solution is successfully completed, a contour map showing 
downward displacement envelope is displayed. If the solution procedure fails, 
a message box appears. Detailed information on the solution may be found in 
the Solve / View Results / Solve 

• After a successful run, results may be v
command. The results can be printed using the File / Print Results command. 
Results may also be plotted using the Solve / View Contours command.  

ng he Results   
Afte
com

• 

r a successful run, the output may be viewed using the Solve / View Results 
mand.  

From the Solve menu, choose View Results to have the program surface the 
VIEW RESULTS folder as illustrated here… 

 
Alternatively, you could have clicked on the  button located on the 

• es: 

• Envelope 

toolbar, and then on the VIEW RESULTS tab.  
The results are categorized into three typ
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• Service 

• Ultimate 

Expand the type you wish to view by clicking on the •  symbol next to the 

•  the 
ore information on the output tables, see Program 

pter 2.  

 AREA.  

s. To print the displayed results, 
File / Print 

Viewing the Contours 

type (ENVELOPE, SERVICE, or ULTIMATE) found in the right ITEM LISTING 
AREA.  

If Service or Ultimate is selected, a combination must be selected from
expandable list. For m
Results in Cha

• Choose the result table to display from the available items in the right ITEM 
LISTING

• The requested information is shown in the GRAPHICS / INPUT AREA. Use the 
scroll bars to navigate through the result
choose the Results command.  

After a successful run, the output may be graphically viewed using the 
Solve / View Contours command. 

• From the Solve menu, choose View Contours to have the program surface 
button located on the toolbar,  

Alternatively, you could have clicked on the  button located on the 
toolbar, and then on the VIEW CONTOURS tab.  

• The results are categorized into three types: 

• Envelope 

• Service 

• Ultimate 

• Once the VIEW CONTOURS folder surfaces, expand the type you wish to view 
by clicking on the  symbol next to the type (ENVELOPE, SERVICE, or 
U ) found in the right I L A .  

•  by expand

PHICS/INPUT AREA. Note that top 
d ments are plotted separately.  

LTIMATE TEM ISTING REA

Locate the results you wish to view graphically ing to the root.  

• The requested contours are shown in the GRA
an  bottom mo
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•  p isplayed contours, choose the File / Print Screen command. To rint the d

 

Acces ins g the 3D View  
The represen
scre  and pan.  

he program surface the 3D VIEW 
d

te , you could have clicked on the 

3D view provides a three dimensional graphic tation of the slab. This 
en allows you to rotate the slab, zoom in, zoom out

• From the View menu, choose 3D to have t
fol er. 

Al rnatively  button located on the 
l hen on the 3D VIEW tab.  

Using the Zoom Comma

fold  only use for displ
purp

too bar, and t

nd: 
The Zoom command is used to enlarge or reduce the image shown in the 3D VIEW 

er in the GRAPHICS / INPUT AREA. This command is d ay 
oses and does not affect the model geometry.  

To Zoom In: 

• With the 3D VIEW folder displayed, click on the  button found at the 
bottom of the GRAPHICS / INPUT AREA.  
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• Using the left-mouse button, marquee select the portion of the graphical image 
you wish to enlarge. The selected area is enlarged to occupy the entire 
GRAPHICS / INPUT area.  

 
To Zoom Out: 

• With the 3D VIEW displayed, click on the  button found at the bottom of 

• e left-mouse button, marquee select the portion of the graphical image 
oportion

D VIEW folder displayed, click on th

the GRAPHICS / INPUT AREA.  

Using th
you wish to reduce. The selected area is pr ally readjusted in the 
GRAPHICS / INPUT area.  

Using the Pan Command:  
The Pan command is used to move the image shown in the 3D VIEW folder in the 
GRAPHICS / INPUT area. Image panning or translation is a linear movement of the 
viewport. This command is only used for display purposes and does not affect the 
model geometry.  

e  button found at the • With the 3
bottom of the GRAPHICS / INPUT area.  
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• Click and hold the left-mouse button on the graphic while dragging it around 
the GRAPHICS / INPUT area. The image is anchored (moved) when the left-
mouse button is released.  

Using the Reset Command:  
The Reset command is used to reset the image shown in the 3D VIEW folder in the 
GRAPHICS / INPUT AREA to its default position.  

• With the 3D VIEW folder displayed, click on the  button found at the 
bottom of the GRAPHICS / INPUT area.  

Alternatively, you could simply right-button click anywhere within the 
GRAPHICS / INPUT area.  

Using the Rotate Command:  
The Rotate command is used (in isometric 3D only) to rotate the 
image shown in the 3D VIEW folder so that the model may be 
viewed from a different viewpoint. This command works with the 
axis-orientation box located at the bottom of the GRAPHICS / INPUT 
area… 

This command is only used for display purposes and does not affect the model 
geometry.  

 VIEW folder displayed, click and hold down the left mouse button 
orientation box.  

lding
ions of both the axis bar as well as the graphic. 

Defining the Options 

• With the 3D
on the axis-

• Drag the mouse in any direction while ho  down the left-mouse button. 
Notice the corresponding rotat
The axis orientation represents the position of the model as soon as the left-
mouse button is released.  

There are many options that can be set as default so that they are saved in memory 
to be applied to any subsequent project until they are changed again.  

From the Options menu, choose Startup Defaults, Autosave, Font & Color or 
Statistics to have the program surface the respective OPTION folder as illustrated. 

te  Al rnatively, you could have clicked on the bu
tool

tton located on the 
bar.  
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To Define the Startup Defaults:  
The Options / Startup Defaults command is used to save the curren
to be used in future input sessions. Default settings are s
PCAPROGS.INI file located in the WINDOWS directory. Settings th
include units of measure, code, and default directories.  

t file settings 
aved in the 

at are saved 

ODE 
riate design code.  

ere any 

t to save. 
See Saving the Data.  

 specify the location of your text viewer (i.e. MS Notepad) and 

To Co

r 
 be name

and) prior to activating this feature.  

• With the STARTUP folder surfaced, from the UNITS options group, choose the 
applicable units of measure and from the C options group, select the 
approp

• Specify a default data directory. The 
path you specify here is wh
data files you save will be saved by 
default. Note, however, that you will 
still be able to specify a different 
location when you attemp

• You may also
you may control the number of lines printed per page.  

ntrol the Autosave feature:  
The Options / Autosave command is used to force the program to save your input 
data to disk at predefined intervals. This minimizes loss of data in case of a powe
loss or computer lock-up. Note that the file must d (using the File / Save 
As comm
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• With the AUTOSAVE folder surfaced, place a checkmark in the ENABLE 
AUTOSAVE box to activate the auto save feature.  

• In the Frequency text box, specify 
the time interval that you would like 
the program to run the autosave 
feature.   

To Customize the Font and Color:  
The Options / Font & Color command is used to change the color settings of the 
graphical image to those of personal preference. 

• With the FONT & COLOR folder surfaced, click on the CHOOSE FONT button to 
select the font type and size that will be used in plotting the node and element 

cal display. The font types that appear in the list are 
NDOWS/FONTS directory. The font you specify here 

To View th
•  

numbers on the graphi
those saved in your WI
is also used in screen-printing.  

• Use the color drop-down lists within the OBJECT COLOR group to select 
preferred colors for the following…  

• Grid  

• Active (object, node or element)  

• Inactive (object, node or element)  

• Frame  

• Background  

e Project Statistics:  
Surface the STATISTICS folder by using the Options / Statistics command…  

Alternatively, you could have clicked 
on the  button located on the 
toolbar, and then on the STATISTICS 
tab. 

• The folder displays a statistical 
summary on the number of nodes, 
elements and definitions.  
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Chapter 5 
Examples 

Helpful Hints  
1. Many of the procedures in this chapter require that you marquee select the 

region (x1, y1) – (x2, y2). 

 
To marquee select:  
• Place the cursor at the location (

change in the lower part of the scre

• Click and hold down the left-mouse

x1, y1). Notice how the coordinates 
en as you move the mouse cursor.  

 button.  

own, drag to the second location 
ear as you drag the cursor.  

ton.  

• While holding the mouse button d
(x2, y2). A dashed rectangle will app

• Release the mouse but

 



 

2. Both examples make use of the 
following color settings (chosen from 
the Options Menu / Font & Color 
command): 

3. It may also be helpful to set the GRID 
LINE type to Dot, the COORDINATE 
PRECISION to 0.1, and the 3D FACTOR 
to 1.  

Example 1 
The 10' x 10' x 2' footing is presented in Joseph F. Bowles’ Foundation Analysis 
and Design, Fourth Edition, 1988, p.461. 

A 500-kip load is applied at the center of the footing.  

Use the following data: 

concrete:  = 3.0 ksi, 

 wc = 148 pcf, 

 Ec =3,254ksi, 

 v = 0.15, 

soil: subgrade modulus = 100 kcf,

 allowable pressure = 6 ksf, 

steel: fy = 60 ksi, 

 Es = 29,000 ksi. 

The origin of the XY plane will be located at the lower left-hand corner of the 
footing. Two-foot square elements will be used; thus, the grid system consists of 
six grid lines (i.e. five elements), two feet apart, in each direction. The 
concentrated load will be applied as four nodal loads (125 kip each). The finite 
element mesh is shown at the end of this example.  

Inputting Problem Databases 
1. From the Define menu, select General Info to surface the DESCRIPTION 

folder… 

24” x 24”
column

'
cf
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• Input the project information and select ENGLISH units along with the ACI 

code. Notice how the current date and time is displayed by default.  

2. From the Define menu, select Grid, or simply click on the  tab to 
surface the respective folder…  
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Since the grid layout is uniform, and sy
grid lines will be generated.  
• Double-click on the GENERATE op

the prog

mmetrical in both directions, X and Y 

tion in the ITEM LISTING AREA to have 
ram surface the following…  

 
• Place a check mark in the X- DIRECTION box and enter the following 

values in the corresponding text boxes…  

IDS:   6 
D S   2 

• Repeat the a p for the Y-DIRECTION.  

• Clic RATE button to return focus to
how rid lines now appear in the GRAPHICS/INPUT AREA.  

3 From the enu, choose Thickness to surface the PROPERTIES folder… 

FROM DISTANCE:   0 
NUMBER OF GR

GRI PACING:  
bove ste

k on the GENE  the GRID folder. Notice 
 the X and Y g

.  Define m

 
• Input Thick1 for LABEL and 24.0 for THICKNESS.  

• Click on the ADD button to add the entry to the list.  

4. From the Define menu, choose Soil,  

ing… 

L

SUBGRADE MODULUS:  100 kcf 

• Enter the follow

LABE :    Soil1 
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ALLOWABLE PRESSURE:   6 ksf 
• Click on the ADD button to add the entry to the list.  

5. From the Define menu, choose Concrete or click on the CONCRETE option in 
the ITEM LISTING AREA to have the program surface the respective folder.  

• Enter the following… 

LABEL:     Conc1 
COMPRESSIVE STRENGTH:   3 ksi 
UNIT WEIGHT:   148 pcf 
YOUNG’S MODULUS:  3245 ksi 
POISSON’S RATIO:   0.15 

• Click on the ADD button to add the entry to the list.  

6. From the Define menu, choose Reinforcing Steel or click on the 
REINFORCEMENT option in the ITEM LISTING AREA to have the program 
surface the respective folder.  

YOUNG’S MODULUS:  29000 ksi 
• Click on the ADD button to add the entry to the list.  

7. From the Define menu, choose Design Parameters or click on the DESIGN 
PARAMETERS option in the ITEM LISTING AREA to have the program surface 
the respective folder.  

• Enter the following… 

LABEL:    DC1 
MIN. REINF. RATIO:   0.18 % 
X-DIR  (TOP):    3.25 in 

(BOTTOM):  3.25 in 
Y-DIR  (TOP):    3.75 in 

(BOTTOM):   3.75 in 
• Click on the ADD button to add the entry to the list.  

• Enter the following… 

LABEL:    Steel1 
YIELD STRENGTH:    60 ksi 
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From the Define menu, select Loads, or simply click on the 8.  tab to 
surface the respective folder… 

 
• ITEM LISTING

• from the L ter –125 for Pz.  

• st.  

9. From s, or simply click on the 

 Select CONCENTRATED from the  AREA and enter P1 for 
LABEL.  

Select A OAD CASE drop-down list and en

Click on the ADD button to add the entry to the li

 the Define menu, choose Load Combination
 tab to surface the respective folder…  

• 

• Check the SAVE RESULTS box and click on the ADD button to add the 
entry to the list.  

• From the LEVEL drop-down list, select ULTIMATE.  

• Enter U1 for LABEL  

• Enter 1.0 for CASE A and 0.0 for all other cases.  

DD button to add the 

 WEIGHT IN CASE A 

• From the LEVEL drop-down list, select SERVICE.  

Enter S1 for LABEL  

• Enter 1.0 for CASE A and 0.0 for all other cases.  

• Check the SAVE RESULTS box and click on the A
entry to the list.  

• Click on t OPTIONS button to surface the he 
following…  

• Clear the Include SELF
option and click on the OK button to return 

cus to the L Cfo OAD OMBINATIONS folder.  
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Assigning Prop
10. spective folder.  

-1) 
ickness to the entire footing. The selected elements 

ment and node numbers, from the Define 
, double click on 

11. Fro ption in the ITEM 
LIST

d select SOIL1.  

12. g the Assign / Concrete, Assign / Reinforcing 
Stee ply CONCRETE1, 
STE

13. Fro  on the

erties  
From the Assign menu, select Thickness to surface the re

• From the ITEM LISTING AREA, select THICK1.  

• In the GRAPHICS/INPUT AREA, marquee-select the region (-1, 11)-(11, 
to apply the selected th
are redrawn in red.  

Note: To see the assigned ele
menu, select Grid, and once the GRID folder surfaces
PREFERENCES.  

m the Assign menu, select Soil or click on the SOIL o
ING AREA.  

• Expand the SOIL listing in the ITEM LISTING AREA an

• In the GRAPHICS/INPUT AREA, marquee-select the region (-1, 11)-(11, -1) 
to apply the selected soil to the entire footing. The selected elements are 
redrawn in red.  

Repeat the step above usin
l and Assign / Design Parameters commands to ap
EL1 and DC1 properties to the entire footing.  

m the Assign menu, select Nodal Loads or simply click   
tab to surface the respective folder.  

REA, click on each of the four nodes (4, 4), (6, 4), (4, 6) 
 are shown indicating loaded nodes… 

• In the ITEM LISTING AREA, expand Case A and then expand Concentrated 
to select P1.  

• In the GRAPHICS A
and (6,6). Small red squares
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Solving  
14. nu, select Execute to surface the SOLVER folder… From the Solve me

 
• Enter 10, 12, 50 and 0 in the text boxes and choose the Maximum 

moment within an element option.  

• r window is displayed and t
iately be passed to the 

• Click on the Run button.  

The pcaMats Solve he solver messages are 
listed. After the solution is done focus will immed
View Results folder.  
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Viewing and Printing Results  
nd. 

le ayed box or using the 

16.  
com
Scr

15. To view the results in text format, use the Solve / View Results comma
Se ctive printing may be done from the displ
File / Print Results command.  

To view the results in graphical format, use the Solve / View Contours 
mand. A printout of the screen may be obtained using the File / Print 

een command. 

 

 
Element and Node Numbering for Example 1 
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Displacement contours for Example 1 

5-10  Examples 



 

Example 2  
Analyze the mat shown… 

 
The mat is supported on two types of soil, soil-1 and soil-2, as shown in the figure. 
Use the following data: 

concrete:  = 3.0 ksi, 

 wc = 145 pcf, 

 Ec =3,156ksi, 

 v = 0.15, 

soil-1: 

'
cf

subgrade modulus = 50 kcf, 
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 allowable pressure = 6 ksf, 

soil-2: subgrade modulus = 75 kcf, 

 allowable pressure = 8 ksf, 

steel: fy = 60 ksi, 

 Es = 29,000 ksi. 

The superstructure was analyzed for wind loads. The resulting reactions for the 
columns and wall, as well as the dead and live loads, are as follows: 

  Dead Live Wind 

Column Pz (kip) -50 -35 -10 

 Mx (ft-kip) 0 0 5 

 My (ft-kip) 0 0 0 

Wall Pz (kip) -376 -208 -80 

 Mx (ft 60 -kip) 0 0 

 My (ft-kip) 0 0 0 

 

The mat will be analyzed for three service combinations and three ultimate 
combinations. Deflections and pressures are to be checked for the service 
combinations and the mat will be designed (compute required reinforcement) for 
the ultimate combinations.  

Service Combinations: S1 = D+L 
  S2 = D + L + W 
  S3 = D + W 

Ultimate Combinations: U1 = 1.4 D 
    U2 = 1.2 D + 1.6 L 
    U3 = 1.2 D + 1.0 L 
    U4 = 1.2 D + 0.8 W 
    U5 = 1.2 D + 1.0 L + 1.6 W 
    U6 = 0.9 D + 1.6 W 
    U7 = 1.2 D - 0.8 W 
    U8 = 1.2 D + 1.0 L - 1.6 W 
    U9 = 0.9 D - 1.6 W 
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The lower left-h
The gri

and corner of the mat is chosen as the origin of the grid system. 
d layout is shown at the end of this example.  

ver five nodes (nodes 205, 229, 253, 277 and 291), the 
wall loads will be divided into equivalent nodal loads depending on the tributary 
length of each node. Furthermore, the Rx degrees of freedom of these five nodes 
are slaved to simulate the stiffening effect of the wall.  

Wall Loading Conditions 

Since the wall is spanning o
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Inputting Problem Databas
1  the Defin fo to surface the DESCRIPTION 

folder… 

es  
. From e menu, select General In

 
• Input the project information and select ENGLISH units along with the ACI 

code. Notice how the current date and time is displayed by default.  

2. From the Define menu, select Grid, or simply click on the tab to surface the 
respective folder. 

The X-Grid will be ted in three parts acrea s per the illustration below… 
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• Double-click on the GENERATE option in the ITEM LISTING AREA to have 

the program surface the GENERATE dialog box.  

• Place a check mark in the X-Direction box and enter the following values 
in the corresponding text boxes…  

FROM DISTANCE:   0 
NUMBER OF GRIDS:   12 
GRID SPACING:   2 

• Place a check mark in the Y-Direction box and enter the following values 
in the corresponding text boxes…  

FROM DISTANCE:   0 
NUMBER OF GRIDS:   20 
GRID SPACING:   2 
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• Click on the GE
how the X and 

NERATE button to return focus to the GRID folder. Notice 
 AREA. 

grid lines have only been generated for section 1 as per the 
illustration above.  

• To create the two grid lines in section 2, 
double-click on the SET UP option in the 
ITEM LISTING AREA to have the program 
surface the following dialog box… 

•  With the X-DIRECTION option chosen 
input 25 in the COORDINATE text box and 
click on ADD.  

• Input 28 in the COORDINATE text box and 
click on ADD.  

• Click on OK to return focus to the GRID folder. Note how the two grid 
lines just added now appear in the GRAPHICS/INPUT AREA.  

•  To create the remaining grid 
lines in the third section, double-
click on the GENERATE option in 

 mark in the X-DIRECTION box and enter the following 

FROM DISTANCE:   30  
NUMBER OF GRIDS:   10  
GRID SPACING:   2  

• Click on the GENERATE button to return focus to the GRID folder. Notice 
how the 10 new X grid lines now appear in the GRAPHICS/INPUT AREA.  

3. From the Define menu, choose Thickness to surface the PROPERTIES folder…  

Y grid lines now appear in the GRAPHICS/INPUT
Note that you have just generated the Y-Grid lines for the entire slab and 
the X-

the Item Listing Area to have the 
program surface the GENERATE 
dialog box, shown here for 
illustrative purposes…  

• Place a check
values in the corresponding text boxes…  
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• Input Thick1 for LABEL and 24.0 for THICKNESS.  

• .Click on the ADD button to add the entry to the list.  

• Input Thick21 for LABEL and 36.0 for THICKNESS.  

• Click on the ADD button to add the entry to the list.  

4. 
ST

 Soil1 

• st.  

oil2 

• st.  

From the Define menu, choose Soil, or click on the SOIL option in the ITEM 
LI ING AREA to have the program surface the respective folder.  

• Enter the following… 

LABEL:    
SUBGRADE MODULUS:  50 kcf 
ALLOWABLE PRESSURE:  6 ksf 
Click on the ADD button to add the entry to the li

• Enter the following… 

LABEL:    S
SUBGRADE MODULUS:  75 kcf 
ALLOWABLE PRESSURE:  8 ksf 
Click on the ADD button to add the entry to the li
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5. 
the I

• 

NGTH:  3 ksi
f 

 ksi 

• ntry to the list.  

6. ing Steel or click on the 
REIN  AREA to have the program 
surf e folder.  

29000 ksi 

7. From  Parameters or click on the DESIGN 
PAR NG AREA to have the -program surface 
the 

• 

 % 

• 

then select the SLAVED NODES option in the ITEM LISTING AREA to surface the 
respective folder…  

• Enter Wall Rx1 in the LABEL text boxes.  

From the Define menu, choose Concrete or click on the CONCRETE option in 
TEM LISTING AREA to have the program surface the respective folder. 

Enter the following… LABEL: Conc1 

COMPRESSIVE STRE  
UNIT WEIGHT:    145 pc
YOUNG’S MODULUS:  3156
POISSON’S RATIO:   0.15 
Click on the ADD button to add the e

From the Define menu, choose Reinforc
FORCEMENT option in the ITEM LISTING

ace the respectiv

• Enter the following… 

LABEL:    Steel1 
YIELD STRENGTH:   60 ksi 
YOUNG’S MODULUS:  

• Click on the ADD button to add the en

 the Define menu, choose Design
AMETERS option in the ITEM LISTI
respective folder.  

Enter the following… 

try to the list.  

LABEL:    DC1 
MIN. REINF. RATIO:   0.18
X-DIR  (TOP):   3.25 in 
  (BOTTOM):  3.25 in 
Y-DIR  (TOP):   3.50 in 

 (BOTTOM):  3.50 in 
Click on the ADD button to add the entry to the list.  

8. From the Define menu, select Slaved Nodes, or simply click on the   tab and 
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• Select Rx from the DEGREE OF FREEDOM group.  

• Click on the ADD button to add the entry to the list.  

9. From the Define menu, select Loads, or simply click on the tab to surface the 
respective folder… 

 
•  Select CONCENTRATED from the Item Listing Area and enter PD1 for 

LABEL.  

• Select A from the LOAD CASE drop-down list and enter the following… 

e to enter the remaining two dead loads shown in 
d PD3). 

 

 

Pz = -50 kips  
Mx= 0 k-ft 
My= 0 k-ft 

• Click on the ADD button to add the entry to the list.  

• Repeat the 3 steps abov
the table below (PD2 an
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Case Label Pz Mx My 

PD1 -50 0 0 A 

PD2 -47 0 0 

PD3 -94 0 0 

 
• a and enter PL1 for 

• 

• e loads shown in 

My 

Select CONCENTRATED from the Item Listing Are
LABEL. 

• Select B from the LOAD CASE drop-down list and enter the following… 

Pz = -35 kips  
Mx= 0 k-ft 
My= 0 k-ft 
Click on the ADD button to add the entry to the list.  

Repeat the 3 steps above to enter the remaining two liv
the table below (PL2 and PL3) 

Case Label Pz Mx 

PL1 -35 0 0 

PL2 -26 0 0 

B 

PL3 -52 0 0 

 
• nd enter PW1 for 

• o e following… 

s above to enter the remaining three wind loads shown in 

Select CONCENTRATED from the Item Listing Area a
LABEL.  

Select C from the LOAD CASE drop-d wn list and enter th

Pz = -10 kips 
Mx= 5 k-ft
My= 0 k-ft 

 

• Click on the ADD button to add the entry to the list.  

• Repeat the 3 step
the table below (PW2, PW3 and PW4).  
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Case Label Pz Mx My 

PW1 -10 5 0 C 

PW2 -10 0 0 

PW3 -20 0 0 

PW4 -20 60 0 

 
10. From the Define menu, choose Load Combinations, or simply click on the   

tab to surface the respective folder…  

• From the LEVEL drop-down list, select SERVICE.  

• Enter S1 for LABEL  

• Enter 1.0 for CASE A and CASE B and 0.0 for all other cases.  

• Check the SAVE RESULTS box and click on the ADD button to add the 
entry to the list.  

• Enter S2 for LABEL  

• Enter 1.0 for case A, Case B and Case C and 0.0 for cases D, E and F.  

• Check the SAVE RESULTS box and click on the ADD button to a he 
e list.  

• for LABEL and 1.0 for Case A and Case C. Enter 0.0 for all other 

• E RESULTS box and click on the ADD button to add the 
.  

• EVEL drop-down list, select ULTIMATE and enter U1 for 

ASE 

 Enter U2 for LABEL and 1.2 for CASE A, 1.6 for CASE B, and 0.0 for all 
other cases. 

dd t
entry to th

Enter S3 
cases.  

Check the SAV
entry to the list

From the L
LABEL.  

• Enter 1.4 for C A, and 0.0 for all other cases. 

• Check the SAVE RESULTS box and click on the ADD button to add the 
entry to the list. 

•
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• Check the S SULTS box  click on th D button to  the 
en e lis

• Enter U3 for L  

• Enter 1.2 for C 0 for C , and 0.0 for  other cases. 

• he SAVE RESULTS box and click on the ADD button to add the 
ntry to the list. 

• E RESULTS box and click on the ADD button to add the 
. 

• LABEL 

 and 0.0 for all other 

• and click on the ADD button to add the 
en e list

• Enter U6 for L  

• Enter 0.9 for C 6 for C , and 0.0 for  other cases. 

• Check the SA ESULTS box click on the DD button to d the 
entry to the lis

• nter U7 for LABEL 

e 

• ABEL 

• r CASE A, 1.0 for CASE B, -1.6 for CASE C, and 0.0 for all 

•

• Enter U9 for LABEL 

AVE RE  and e AD  add
try to th t. 

ABEL

ASE A, 1. ASE B  all

Check t
e

• Enter U4 for LABEL 

• Enter 1.2 for CASE A, 0.8 for CASE C, and 0.0 for all other cases. 

Check the SAV
entry to the list

Enter U5 for 

• Enter 1.2 for CASE A, 1.0 for CASE B, 1.6 for CASE C
cases. 

Check the SAVE RESULTS box 
try to th . 

ABEL

ASE A, 1. ASE C  all

VE R
t. 

 and  A ad

E

• Enter 1.2 for CASE A, -0.8 for CASE C, and 0.0 for all other cases. 

• Check the SAVE RESULTS box and click on the ADD button to add th
entry to the list. 

Enter U8 for L

Enter 1.2 fo
other cases. 

 Check the SAVE RESULTS box and click on the ADD button to add the 
entry to the list. 
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• E .9 for , -1.6 for C C, and 0.0 f  other cases

• Check the SA SULTS box on 
the ADD butto d the entry e list. 

• Click on the NS button 
following… 

• Clear the Inc ELF WEIGH CASE A opt d click on e OK 
utton to return focus to the LOAD COMBINATIONS folder. 

Assign
11.  to surface the respective folder. 

TEM ISTING REA HICK

NPUT AREA, marquee-select the region (-1,39) – (23, -1) 

part of the footing. Notice how the selected regions are 

nter 0 CASE A ASE or all . 

VE RE  and click 
n to ad  to th

OPTIO to surface the 

lude S T IN ion an  th
b

ing Properties  
From the Assign menu, select Thickness

• From the I L A , select T 1. 

• In the GRAPHICS/I
to apply the selected thickness to that part of the footing. 

• Marquee-select the region (27,21) – (49, -1) to apply the selected 
thickness to that 
redrawn in red… 
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• From the ITEM LISTING AREA, select THICK2. Note that the regions 
defined in the previous steps are redrawn in cyan, indicating that they 

 than THICK2.  

 (29, -1) 

id, and once the GRID folder surfaces, double click on 

he ITEM 

T AREA, marquee-select the region (-1,39) – (29, -1) 
il to that part of the footing. The selected elements 

• OIL2 and in the Graphics / Input Area, marquee-select the region 

 are redrawn in red.  

12. elect Concrete or click on the CONCRETE option in 
e I REA

ONCRETE listi NG 

/INPUT AREA, marquee-select the region (-1,39) – (49, -1) 
concrete to the entire footing. The selected elements 

13. 
s

entire foo

14. select Slaved Loads or simply click on the tab to 

• LISTING AREA, expand the SLAVED NODES item to display 

have a thickness other

• In the GRAPHICS/INPUT AREA, marquee-select the region (21,39) –
to apply the selected thickness to that part of the footing. 

Note: To see the assigned element and node numbers, from the Define 
menu, select Gr
PREFERENCES. 

• From the Assign menu, select Soil or click on the SOIL option in t
LISTING AREA. 

• Expand the SOIL listing in the ITEM LISTING AREA and select SOIL1. 

• In the GRAPHICS/INPU
to apply the selected so
are redrawn in red.  

Select S
(27,21) – (49, -1) to apply the selected soil to that part of the footing. The 
selected elements

From the Assign menu, s
th TEM LISTING A .  

• Expand the C ng in the ITEM LISTI AREA and select 
CONC1.  

• In the GRAPHICS
to apply the selected 
are redrawn in red.  

Repeat the step above using the Assign / Reinforcing Steel and Assign / 
De ign Parameters commands to apply STEEL1 and DC1 properties to the 

ting.  

From the Assign menu, 
surface the respective folder. 

In the ITEM 
WallRx1 – select it.  
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• In the GRAPHICS AREA, marquee-select the region (24,25) – (26,15). The 
thin e select

15. nu, se  simply click on the tab to 

, ex and  

• In the GRAPHICS AREA, click on each of the following nodes (2,2), (25,2), 
(2,18), (46,18), (2,36) and (25,36). Small red squares are shown 

S AREA, click on the nodes 

• In the GRAPHICS AREA, click on each of the following nodes (2,2), (25,2), 
(46,2), (2,18), (46,18), (2,36) and (25,36). 

• Select PL2 from the list box. In the GRAPHICS AREA, click on the nodes 
(25,16) and (25,24). 

• Select PL3 from the list box. In the GRAPHICS AREA, click on the nodes 
(25,18), (25,20) and (25,22). 

• In the ITEM LISTING AREA, expand Case C and then expand 
CONCENTRATED to select PW1. 

• In the GRAPHICS AREA, click on each of the following nodes (2,2), (25,2), 
(46,2), (2,18), (46,18), (2,36) and (25,36). 

• Select PW2 from the list box. In the GRAPHICS AREA, click on the nodes 
(25,16) and (25,24). 

• Select PW3 from the list box. In the GRAPHICS AREA, click on the nodes 
(25,18) and (25,22). 

• Select PW4 from the list box. In the GRAPHICS AREA, click on the node 
(25,20). 

five nodes wi  th ed region are redra
assigned to the slaved nodes group WallRx1.  

wn in red. These nodes are 

From the Assign me lect Nodal Loads or
surface the respective folder. 

• In the ITEM LISTING AREA p Case A and then expand
CONCENTRATED to select PD1. 

(46,2), 
indicating loaded nodes. 

• Select PD2 from the list box. In the GRAPHIC
(25,16) and (25,24). 

• Select PD3 from the list box. In the GRAPHICS AREA, click on the nodes 
(25,18), (25,20) and (25,22). 

• In the ITEM LISTING AREA, expand Case B and then expand 
CONCENTRATED to select PL1. 

Examples  5-25 



 

 

Solving  
16. From the Solve menu, select Execute to surface the SOLVER folder… 
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• Enter 10, 12, 50 and 0 in the text boxes and choose the MAXIMUM 
MOMENT WITHIN AN ELEMENT option. 

Click on the RUN button. • 

done focus will automatically be passed to the 

Viewing a P
17. To 

Sele

18. 
com  the screen may be obtained using the File / Print 

• The pcaMats Solver window is displayed and the solver messages are 
listed. After the solution is 
VIEW RESULTS folder. 

nd rinting Results  
view the results in text format, use the Solve / View Results command. 
ctive printing may be done from the displayed box or using the File / 

Print Results command. 

To view the results in graphical format, use the Solve / View Contours 
mand. A printout of

Screen command. 

 
Sample Results for Example 2 
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Service Envelope Displacement Contours for Example 2 

 
Element Numbering for Example 2 
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Node Numbering for Example 2 
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Appendix 
Conversion Factors - English to SI 

 
To convert from  To  Multiply by 

in. m (1000 mm)  0.025400 
ft m  0.304800 
lb N (0.001 kN)  4.448222 

kip (1000 lbs)  kN  4.448222 
plf (lb/ft)  N/m  14.59 904 3

psi (lb/in.2)  6.894757 kPa  
ksi (kips/in.2)  MPa  6.894757 

psf (lb/ft2)  N/m2 (Pa)  47.88026 
pcf (lb/ft3)  kg/m3  16.018460 

ft-kips  kN • m  1.355818 
 

Conversion Factors - SI to English. 
 

To convert from To  Multiply by  
m (1000 mm) in  39.37008  

m ft  3.28084  
N (0.001 kN) lb  0.224809  

kN kip (1000 lbs)  0.224809  
kN/m plf (lb/ft)  68.52601  
MPa psi (lb/in2)  145.0377  
MPa ksi (kips/in2)  0.145038  

kN/m2 (kPa) psf (lb/ft2)  20.88555  
kg/m3  pcf (lb/ft3)  0.062428  
kN • m  ft-kips  0.737562  

 



 

Contact Information 
 

Web Site:  http://www.pcaStructurePoint.com

E-mail:  info@pcaStructurePoint.com  
 support@pcaStructurePoint.com  

Ordering:  pcaStructurePoint  
 Attn: Customer Service  
 5420 Old Orchard Road  
 Skokie, IL 60077  
 USA  
Phone:  (847) 972-9042  
Fax:  (847) 972-9043  

Technical Support:  pcaStructurePoint  
 5420 Old Orchard Road  
 Skokie, IL 60077  
 USA  
Phone:  (847) 966-HELP / (847) 966-4357  
Fax:  (847) 581-0644  

 

A-2  Appendix 



 

Bug Report Form  
To help us improve our products please fax, mail or e-mail questions to:  

5420 Old Orchard Road 
0077 
81-0644  

ail: support@pcaStru

pcaStructurePoint 

Skokie, IL 6
Fax: (847) 5
E-m cturePoint.com
 

Program 
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Problem Title Please enter a brief, one-line description of the problem.  

Summary I
mmary in

nformatio m title and/or include more descriptive 
formation.

n Restate the proble
su   

Error Messages If the m causes any error messages, please list the exact error 
 that you are 

 proble
messages receiving.  

Steps to Reproduce If oducible, please list the steps required to 
use it. If the problem e (only happened once, or occasionally for 

ent reason), p hich it occurred and the 
s observed.  

 the problem is repr
oduciblca  is not repr

no appar
symptom

lease describe the circumstances in w

Results Describe your results and how they differed from what you expected.  

Workaround If there is a workaround for the problem, please describe it in detail.  

Documentation & Notes Document any additional information that might be useful 
in resolving the problem.  
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